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Safety

Safety notices
Safety notices may be printed throughout this guide. DANGER notices warn you of conditions or
procedures that can result in death or severe personal injury. CAUTION notices warn you of conditions or
procedures that can cause personal injury that is neither lethal nor extremely hazardous. Attention
notices warn you of conditions or procedures that can cause damage to machines, equipment, or
programs.

World trade safety information
Several countries require the safety information contained in product publications to be presented in their
translation. If this requirement applies to your country, a safety information booklet is included in the
publications package shipped with the product. The booklet contains the translated safety information
with references to the US English source. Before using a US English publication to install, operate, or
service this product, you must first become familiar with the related safety information in the Systems
Safety Notices, G229-9054. You should also refer to the booklet any time you do not clearly understand
any safety information in the US English publications.

Laser safety information
All IBM Z® (Z) and IBM LinuxONE™ (LinuxONE) models can use I/O cards such as FICON®, Open Systems
Adapter (OSA), InterSystem Channel-3 (ISC-3), RoCE Express, Integrated Coupling Adapter (ICA SR),
zHyperLink Express, or other I/O features which are fiber optic based and utilize lasers (short wavelength
or long wavelength lasers).

Laser compliance
All lasers are certified in the US to conform to the requirements of DHHS 21 CFR Subchapter J for Class 1
or Class 1M laser products. Outside the US, they are certified to be in compliance with IEC 60825 as a
Class 1 or Class 1M laser product. Consult the label on each part for laser certification numbers and
approval information.

Laser Notice: U.S. FDA CDRH NOTICE if low power lasers are utilized, integrated, or offered with end
product systems as applicable. Complies with 21 CFR 1040.10 and 1040.11 except for conformance with
IEC 60825-1 Ed. 3., as described in Laser Notice No. 56, dated May 8, 2019.

CAUTION: Data processing environments can contain equipment transmitting on system links with
laser modules that operate at greater than Class 1 power levels. For this reason, never look into the
end of an optical fiber cable or open receptacle. (C027)

CAUTION: This product contains a Class 1M laser. Do not view directly with optical instruments.
(C028)
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About this publication

This guide is intended to help users of the CHPID Mapping Tool to obtain the tool and learn to use it for
mapping available CHPIDs to PCHIDs.

This guide is available in portable document format (PDF) to view or print from Resource Link® (at http://
www.ibm.com/servers/resourcelink). This guide is also available in HTML format within the CHPID
Mapping Tool itself under the Help menu. For more information about this, see “The Help menu” on page
18.

How to use this guide
This guide includes the following:

• Chapter 1, “Overview,” on page 1 describes the uses of the CHPID Mapping Tool and explains its
requirements.

• Chapter 2, “Obtaining the CHPID Mapping Tool and CFReport file,” on page 5 lists the steps for
downloading from Resource Link:

– The CHPID Mapping Tool (or an update)
– The CFReport file.

Note: You need a valid Configuration Control Number (CCN) to download the CFReport file.
• Chapter 3, “Getting started ,” on page 7 explains how to start the CHPID Mapping Tool and import

your CFReport file and IOCP file. It also provides a tour of the GUI controls of the tool.
• Chapter 4, “Performing hardware resolution,” on page 29 explains why hardware resolution is needed,

describes the Hardware Resolution view (both formats), and provides the steps for performing
hardware resolution.

• Chapter 5, “Miscellaneous tasks,” on page 43 describes how to perform tasks including saving and
restoring session information, loading an IOCP file (if not loaded at project creation), importing and
exporting sessions, and changing preferences.

• Chapter 8, “Manual mapping,” on page 85 explains the Manual Mapping view and provides the steps
for performing manual mapping method.

• Chapter 6, “Strategies and Guidelines for Assigning Priorities,” on page 59 explains how to determine
priorities for automatic mapping.

• Chapter 7, “Assigning priorities, automatic mapping, and processing intersections,” on page 63 lists
steps for assigning priorities, making automatic mapping available, and processing intersections

• Chapter 9, “Reports,” on page 99 lists the steps to create and save reports.
• Chapter 10, “Troubleshooting and support,” on page 109 provides troubleshooting information and the

answers to frequently asked questions.

Figures included in this document illustrate concepts and are not necessarily accurate in content,
appearance, or specific behavior.

Revisions
A technical change from the previous edition of this document is indicated by a vertical line (|) to the left
of the change.
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Accessibility
Accessible publications for this product are offered in EPUB format and can be downloaded from
Resource Link at http://www.ibm.com/servers/resourcelink.

If you experience any difficulty with the accessibility of any IBM Z® and IBM LinuxONE information, go to
Resource Link at http://www.ibm.com/servers/resourcelink and click Feedback from the navigation bar
on the left. In the Comments input area, state your question or comment, the publication title and
number, choose General comment as the category and click Submit. You can also send an email to
reslink@us.ibm.com providing the same information.

When you send information to IBM®, you grant IBM a nonexclusive right to use or distribute the
information in any way it believes appropriate without incurring any obligation to you.

Accessibility features
The following list includes the major accessibility features in IBM Z and IBM LinuxONE documentation,
and on the Hardware Management Console and Support Element console:

• Keyboard-only operation
• Interfaces that are commonly used by screen readers
• Customizable display attributes such as color, contrast, and font size
• Communication of information independent of color
• Interfaces commonly used by screen magnifiers
• Interfaces that are free of flashing lights that could induce seizures due to photo-sensitivity.

Keyboard navigation
This product uses standard Microsoft Windows navigation keys.

Consult assistive technologies
Assistive technology products such as screen readers function with our publications, the Hardware
Management Console, and the Support Element console. Consult the product information for the specific
assistive technology product that is used to access the EPUB format publication or console.

IBM and accessibility
See http://www.ibm.com/able for more information about the commitment that IBM has to accessibility.

How to send your comments
Your feedback is important in helping to provide the most accurate and high-quality information. Send
your comments by using Resource Link at http://www.ibm.com/servers/resourcelink. Select Feedback on
the Navigation bar on the left. You can also send an email to reslink@us.ibm.com. Be sure to include the
name of the book, the form number of the book, the version of the book, if applicable, and the specific
location of the text you are commenting on (for example, a page number, table number, or a heading).
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Chapter 1. Overview

This chapter describes the CHPID Mapping Tool and its requirements.

Overview of the CHPID Mapping Tool
The CHPID Mapping Tool maps the I/O ports of your hardware to the CHPID definitions in your IOCP
source statements. Such mapping helps to avoid connecting critical paths to single-points-of-failure. The
CHPID mapping tool can save you time by minimizing or eliminating changes when you get new hardware
or upgrade existing hardware.

The CHPID Mapping Tool supports the following:

• IBM z15™ (z15) / IBM LinuxONE III
• IBM z14® (z14) / IBM LinuxONE Rockopper II (Rockhopper II)
• IBM z14 (z14) / IBM LinuxONE Emperor II (Emperor II)
• IBM z13s® (z13s®) / IBM LinuxONE Rockhopper (Rockhopper)
• IBM z13® (z13®) / IBM LinuxONE Emperor (Emperor)
• IBM zEnterprise® BC12 (zBC12).
• IBM zEnterprise EC12 (zEC12).
• IBM zEnterprise 196 (z196) and IBM zEnterprise z114 (z114).
• IBM System z10® Enterprise Class (z10 EC) and IBM System z10 Business Class (z10 BC)
• IBM System z9® Enterprise Class (z9® EC) and IBM System z9 Business Class (z9 BC)

You can use the CHPID Mapping Tool for a new build, an upgrade to, or an MES for any supported
processor. You can also use it to change an already installed machine after hardware upgrades increase
the number of STI or InfiniBand links or channels.

No default CHPIDs are assigned to ports of z10 EC, z10 BC, z9 EC, or z9 BC processors. CHPIDs are
assigned in the IOCP source file and mapped to the physical channel paths (PCHIDs). Using the CHPID
mapping tool helps with these assignments. When the resulting IOCDS is loaded during activation of the
CPC hardware, the CHPID to PCHID assignments become part of the configuration.

Using the CHPID Mapping Tool:

• You can maintain the existing IOCP definitions for CHPID assignments to control units. Using the tool
minimizes any changes that you might need to make to in-house documentation, cable labels, and the
hardware configuration definitions (HCDs).

• You can implement a numbering scheme for associating different device types to ranges of CHPID
addresses. For example, you might want to have all DASD devices within a certain CHPID range.

• You do not need to change the existing control units and wiring.

For purposes of this document, consider a CHPID assignment as a logical value that is associated with a
physical entity that is called a PCHID. A PCHID can be a specific port on an ESCON card, OSA-Express®

card, FICON card, ICB, ISC link, and so on. A CHPID is merely an arbitrary number defined within the
IOCP. The mapping tool relates that logical assignment to a PCHID location in the machine.

Requirements
Before using the tool, there are certain requirements that must be satisfied.

• Resource Link ID

© Copyright IBM Corp. 2017, 2019 1



Before using the tool, the user must have a valid user ID and password for Resource Link. The web
address for Resource Link is:

www.ibm.com/servers/resourcelink

An option on the Resource Link Sign-in window allows you to obtain a user ID and password.

After you obtain a Resource Link ID, you can download the CHPID Mapping Tool (or upgrades to the
tool).

• To use the CHPID Mapping Tool, you need a CFReport file. You can obtain the CFReport file in several
ways:

– Your IBM representative can provide you with the CFReport that is generated by e-config and can be
used by the CHPID Mapping Tool.

– You can download your CFReport file from the Resource Link website by identifying your order with
the Configuration Control Number (CCN) for the new processor. When the machine to be mapped is
configured and sent to the manufacturing database from the IBM (e-config), a CCN is associated with
the configuration. You can obtain the CCN:

- From the output listing of the configurator
- From the PCHID Report created by the configurator. Figure 1 on page 2 shows a sample PCHID

Report for the z10 EC. In this example, the CCN is 34549311. 

Figure 1. Sample PCHID Report

Ask your IBM representative to verify that you have the latest CCN associated with the machine order.
• IOCP Source Input

A validated IOCP source input must be provided. There are two ways to get a validated IOCP source
input.

– Use the function in hardware configuration definition (HCD) to generate IOCP source from a validated
work IODF. Validated work IODF is the stage of IODF where all logical definitions are in place except
PCHID definitions. (Logical definitions are in place for channel subsystems, logical partitions,
CHPIDs, control units, and devices.) At this stage HCD allows you to generate IOCP statements. You
can transfer these statements to a PC as an ASCII text file. Then you can use them in the CHPID
Mapping Tool. After PCHIDs have been mapped to the CHPIDs using the tool, the same IOCP source
must be migrated back into HCD.

Attention: You cannot put the output of the CHPID Mapping Tool directly into IOCP. You must
migrate it back into HCD.
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If you generate IOCP statements from HCD, do not manually edit the file. Editing this file might
prevent it from being imported back into the "validated work" IODF.

– Create an IOCP source manually and validate it using:

- The ICP IOCP with an execution parameter of WRTCDS=NO
- The correct SYSTEM=value for the target machine.

For example, use SYSTEM=2094 for a z9 EC.

Some factors must be considered regarding this IOCP source file:

– This file must represent the configuration of the machine that is on order. For example, suppose the
current machine has parallel channels and the new machine does not. The IOCP needs to be changed
to remove the parallel channel definitions.

– The IOCP input must be generated by a level of HCD that supports the target machine. All of the
channels to use on the target machine must be defined. The associated control unit statements must
be included and CHPID types accurately defined. (For example, OSA-Express can have different
CHPID types.

– HCD or IOCP must validate the IOCP source input for the correct target machine. A manually
generated source file might have errors associated with it that would be invalidated by IOCP. The
mapping tool does not do any extensive validation of the source file. The file is presumed to be
correct by IOCP standards.

– The tool does not consider:

- Logical partitions (LPs). (That is, it does not consider which CHPIDs are assigned to which LPs.)
- Switch configurations
- Control unit availability characteristics.

Accordingly, the tool results might not be acceptable for all users. While helpful for many, it cannot
replace an expert system programmer.

You map CHPIDs and export the updated IOCP file from the CHPID Mapping Tool. Then you import the
file back into the same "validated work IODF" from which it was generated.

• The table that follows lists stand-alone application and system requirements:

Table 1. Stand-alone application and system requirements

Category Requirement

Operating system Microsoft Windows (32-bit versions)

System memory 150 MB

Hard disk space 220 MB

Display resolution setting At least 1024 by 768

Overview of tasks for using the CHPID Mapping Tool
The graphical user interface (GUI) of the CHPID Mapping Tool is extensively redesigned. The following
flow chart provides a graphical overview. It shows the tasks you need to perform from downloading the
tool, through mapping, and optionally creating and saving reports.
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Chapter 2. Obtaining the CHPID Mapping Tool and
CFReport file

This chapter explains how to download the CHPID Mapping Tool and the CFReport file. You need to have
the correct Configuration Control Number (CCN) to download this file. For other requirements, see
“Requirements” on page 1.

Download the CHPID Mapping Tool (or an upgraded version)
Perform the following steps to download the CHPID Mapping Tool (or an upgraded version).

Note: If you plan to use a saved session from an earlier version of the tool, export your IOCP file before
upgrading to Version 6.0 or later. You need this IOCP file because the CHPID Mapping Tool does not
restore saved sessions from earlier versions.

1. Log on to Resource Link.
2. Click Tools on the left navigation bar.
3. In the list of tools in the next (Tools) window, click CHPID Mapping Tool. Clicking this link displays the

CHPID Mapping Tool window. From this window, you can perform the following actions:

• Download the CHPID Mapping Tool
• Download the CFReport file (if you have a valid CCN)
• Access an education module
• View the frequently asked questions (FAQ).

4. Click CHPID Mapping Tool - Version 6.xx. Resource Link displays the Download the CHPID Tool
window. From this window you can:

• Obtain the installer for the tool
5. Click the link to download the tool for the first time or upgrade your version.
6. The next window provides the information. If you want to use a saved session from an earlier version,

export your IOCP file before upgrading to Version 6.0 or later. You need to do this because the CHPID
Mapping Tool does not restore saved sessions from earlier versions. If you have satisfied this
requirement, click OK.

7. A license window is displayed. Review the terms of the license, and click I agree to continue (or I
disagree to end the process). Clicking I agree begins the process of downloading the CHPID Mapping
Tool.

Note: You may subscribe to this page by clicking the "subscribe to this page" link at the top right hand
corner of the Download the CHPID Mapping Tool window. Once you subscribe you will be notified
when a new version of the tool is available for download.

Obtaining the CFReport file
The CHPID Mapping Tool uses the CFReport file. Your service representative can provide you with a
softcopy of this file, which e-config generates. Alternately, you can download a copy of your CFReport file
on Resource Link.

Before you begin: To obtain the CFReport file, you need to know your CCN. The CCN is an 8-digit number
that is the unique identifier for the ordered machine. It is critical that you verify with the service
representative that you have the correct number.

Perform the following steps to obtain the CFReport file: 
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1. Log on to Resource Link if you are not already logged on to it.
2. Click Tools in the navigation bar on the left.
3. In the list of tools in the Tools window, click CHPID Mapping Tool. Resource Link displays the CHPID

Mapping Tool window.
4. Click CFReport (I/O Configuration Data). Resource Link displays the CFReport Download window.

Figure 2 on page 6 displays this window. 

Figure 2. CFReport Download window
5. Enter the CCN in the Control number field, and click Submit.
6. If there are no problems, downloading begins.

A File Download window is displayed, followed by a Save As window. These windows allow you to
specify the location to save the file and on. You are recommended to always use .cfr as the extension
for this file. You can use any name you want for the high-order name but are recommended not to
change it. When the file is downloaded from Resource Link, the name is <CCN>.cfr.

7. If there are problems with the CCN, an error message is displayed on the CFReport Download window
under the Control number field: 

   Control number: control_number not found

One reason the CCN could be incorrect is that the processing of the order from the IBM configurator
might not have completed running. As part of the configuration process, the service representative
running the configurator must send the order to the manufacturing database. You can click the Help
about CFReport download link to display a window listing additional information.

If you cannot readily figure out the problem, contact your service representative as soon as possible,
or click Feedback in the navigation bar on the left on Resource Link.
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Chapter 3. Getting started

This chapter provides:

• Information about starting the CHPID Mapping Tool. (See “Starting the tool” on page 7.)
• Directions for creating a project, including importing the CFReport file and IOCP input file. (See

“Creating a project” on page 9.)
• Descriptions of the elements of the IBM Channel Path ID Availability and Mapping Tool window and how

to manipulate them. These elements include:

– Views (This chapter shows the Hardware Resolution view as an example because the tool displays
this view after you create a project. The chapter references other views whose detailed descriptions
are in other chapters.)

– Panes
– Columns of information

• Graphical user interface (GUI) elements:

– Menus (see “Menus ” on page 16)
– Buttons (see “Buttons” on page 20)
– Other controls (see “Using other GUI controls to control the panes” on page 23)

Starting the tool
Before you begin: You must have already downloaded the CHPID Mapping Tool from Resource Link and
obtained the CFReport file.

If you are updating the CHPID Mapping Tool, see “Updating the tool” on page 52.

After you download and install the CHPID Mapping Tool, its icon is available on your desktop. Figure 3 on
page 7 shows the icon.

Perform the following steps to start the tool:

1. Double-click the CHPID Mapping Tool icon to open the tool. Figure 3 on page 7 shows this icon. 

Figure 3. CHPID Mapping Tool icon

A splash screen window that identifies the tool is displayed and closes itself. shows this window. The
window displays:

a. The full name of the CHPID Mapping Tool
b. The current version of the CHPID Mapping Tool, in this case Version 6.20. The version of the tool is

incremental when functionality is added.
c. A licensing statement

The first time you open the CHPID Mapping Tool, the IBM CHPID Mapping Tool Welcome window
opens. The tool displays this window after the blue wave window closes. Figure 4 on page 8 shows
this window.
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Figure 4. IBM CHPID Mapping Tool Welcome window
2. Click Start Session, a link in red near the bottom of the window. (Or you can click the X on the

Welcome tab.)

The Welcome window closes, and the IBM CHPID Mapping Tool window opens. Figure 5 on page 9
shows this window. (See page “Welcome Window” on page 18 for a detailed description of the
Welcome Window.)

Note: The tool opens the Welcome window in the following situations:

• The first time you open the tool
• If you used the tool before but did not save session information.
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Figure 5. IBM CHPID Mapping Tool window with Projects pane

Creating a project
The CHPID Mapping Tool allows you to specify the CFReport file and IOCP input file when creating a
project. You cannot rename or replace these files within the tool after project creation. Do not work
outside the tool to access these or any other files or directories the CHPID Mapping Tool uses; doing so
might make the project files unusable.

Before you create a project, the IBM CHPID Mapping Tool window displays the following panes:

• The Projects pane on the left
• A blank pane on the left.

Figure 5 on page 9 shows the window containing these panes.

Perform the following steps to create a new project:

1. Right-click in the Projects pane (by default the leftmost pane), and click New > Standard CMT Project.
Figure 6 on page 10 shows this sequence. 
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Figure 6. Creating a new project

The New CHPID Mapping Tool Project window opens. You use this window to specify a project name.
Figure 7 on page 10 shows this window.

Figure 7. New CHPID Mapping Tool Project window
2. Type the name of your project in the Project name field. 

Note: There is no facility within the CHPID Mapping Tool for renaming a project. Do not attempt to do
so by directly accessing the project folder outside the tool. To do so might make the project files
unusable.

(You can optionally change the default location where the project information is stored. To do so, clear
Use default location, and browse to the location you want.)
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After you type in the name, Next becomes available. Click Next.

The New CHPID Mapping Tool Project window displays fields where you specify the source CFReport
and IOCP input files.Figure 8 on page 11 shows this.

Figure 8. New CHPID Mapping Tool Project window
3. Specify the name of the CFReport file in the CFReport File field.

Note:

a. Specifying a CFReport file is required.
b. The tool copies the CFReport file you specify into a subfolder of the Workspace/Project folder.

(The path is: Workspace/Project/Input/CFR.
c. You cannot change or rename the CFReport file after creating a project. If you create a project and

need a different CFReport file, you need to create a new project.

One way to do this is to browse to the file. Perform the following steps:

a. Click Browse beside the CFReport file field. The Open window opens. 
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Figure 9. Open window (for CFReport file)
b. Select a CFReport file. After you click the file to select it, the File name field at the bottom of the

window is completed. Click Open. The tool returns you to the New CHPID Mapping Tool Project
window. The name of the CFReport file is displayed in the CFReport file field.

Another way to specify the CFReport file is to type the path and file name in the CFReport file field.
4. If the Select Machine window opens, this means your CFReport file references multiple systems. You

need to select the appropriate system. Figure 10 on page 12 shows the Select machine window.

Figure 10. Select Machine window

Select a machine from the list and click OK.
5. Optionally, specify the IOCP input file.

Note:
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a. If you do not import the IOCP input file at this point, you can do this later. See “Importing the IOCP
file” on page 45.

b. The tool copies the IOCP input file you specify into a subfolder of the Workspace/Project folder.
(The path is: Workspace/Project/Input/IOCP.)

c. If you do not import an IOCP input file, you can still use the tool to create most reports but cannot
perform any mapping. (You can create all reports except the Control Unit Report and the CHPID to
Control Unit Report. See Chapter 9, “Reports,” on page 99 for details about reports.)

d. You cannot change or rename the IOCP input file after creating a project. If you create a project and
need a different IOCP input file, you need to create a new project.

6. Click Browse beside the IOCP input file field. The Open window opens.

Click an IOCP input file to select it, and click Open. The tool returns you to the New CHPID Mapping
Tool Project window. The name of the IOCP input file you selected is displayed in the IOCP input file
field.

7. Click Finish.

Note: If you click Finish but have not selected an IOCP input file, you receive the following message: 

Figure 11. Message that you did not specify the IOCP file

You can click OK to continue without selecting an IOCP input file or click Cancel for another
opportunity to select an IOCP input file (return to Step “5” on page 12).

After you click Finish, the tool displays a window depicting the progress of reading the CFReport file.
Figure 12 on page 13 shows this window. 

Figure 12. Reading CFReport window

The tool also displays the name of the project in the lower-left corner of the main window and the
progress of the project creation in the lower-right corner. Figure 13 on page 13 shows these
indicators. 

Figure 13. Project name and progress bar
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8. If your CFReport file describes a miscellaneous equipment specification (MES), the Select IOCP Input
File Source window opens. The purpose of this window is to specify whether the selected IOCP input
file represents the old or the proposed configuration.

Figure 14. Select IOCP Input File Source

Choices are:
IOCP input file represents current configuration

Select this choice if the loaded IOCP input file represents the old system (you have not changed
the IOCP input file before loading it into the CHPID Mapping Tool). This situation is the most
common.

IOCP input file represents proposed configuration
Select this choice if the IOCP input file represents the new system (you manually changed the
IOCP input file before loading it into the CHPID Mapping Tool).

9. If the CFReport file has AID values that cannot be determined, the tool assigns temporary values and
displays the following window: 
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Figure 15. Temporary AID Values Assigned window

Figure 16 on page 15. shows the IBM CHPID Mapping Tool window after you have created a project.

Figure 16. CHPID Mapping Tool window after project creation

The Hardware Resolution view is one of several different views the tool can display in the CHPID Mapping
Tool window. In this view, the Hardware Resolution tabbed pane is the central pane. You can switch
views by clicking (Hardware Resolution,Preview Report and so on) near the top of the window. For more
information, see “Views” on page 22 and “Buttons” on page 20.

Note: The Hardware Configuration Manager (HCM) can use the CHPID Mapping Tool to create or update a
project. (It can also use the tool to update an IOCP file.) When HCM opens the CHPID Mapping Tool, you
specify whether to create a new project or use an existing project. If you are creating a new project, the
tool prompts you for the CFReport file; see Figure 8 on page 11. The tool fills in the IOCP file field.

The Projects pane
The Projects pane is present in all views. By default, it is the leftmost pane, and, if there is more than one
pane is on the left, it is the top pane. You have already used the Projects pane to create a project (see
“Creating a project” on page 9). Figure 17 on page 16 shows an example of the Projects pane.
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Figure 17. Projects pane

The Projects pane is present in the Hardware Resolution view and in other views. It allows you to create
or delete a project. After you create a project, this pane displays information about projects in a tree-style
format. You can click to expand the project and the items under it.
Input

This folder contains input folders. It expands to show two subfolders:
CFR

This folder contains the CFReport file or files.
IOCP

This folder contains the IOCP input file or files.
Reports

This folder contains any generated reports.

Note: Most reports are available (after loading the CFReport) even before loading the IOCP input file.
Only the Control Unit Report and the CHPID to Control Unit Report require loading the IOCP input file.
You can generate any report (for example, the CHPID Report) before assigning CHPIDs, but the CHPID
field is empty in this case.

session.cmt.dat
This is a session file. It saves all the data you have worked on during the session and enables you to
switch between projects. Double-click if you have multiple projects. This action loads the contents of
the file into the mapping session.

You can perform various tasks relating to projects in the Projects pane. For details, see “Tasks accessed
in the Projects pane ” on page 43.

Menus
Menu items at the top of the CHPID window include:

• File
• Window
• Help.

The File menu
Figure 18 on page 17 shows the selections under the File menu.
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Figure 18. File menu

The File menu includes the following selections:
Save Session

This option saves information including:

• CFReport file
• IOCP input file
• Hardware resolution, CHPID assignment, or any other changes you have made during the session.

Note: The current version of the CHPID Mapping Tool (Version 6.xx) does not restore sessions saved
from earlier versions. If you want to use a session from an earlier version, export your IOCP file before
upgrading to Version 6.xx.

Import Session
Imports a saved session.

Export Session
This option opens a window to allow you to save any changes you have made and specify a new name.

Export IOCP Input File
This option allows you to save an updated IOCP input file. The statements in the IOCP input file
include the assignments you have made with the CHPID Mapping Tool.

Exit Application
Closes the tool and exits the program.

If you have changed or updated CHPID assignments, the tool prompts you to save your session.
However, you are recommended to click Save Session or Export Session before exiting any program.
The change or update of CHPID assignments could be: change the IOCP type of CHPIDs, change of
CHPID groups, or change the mapping between CHPID and PCHID.

The Window menu
Figure 19 on page 17 shows the selections under the Window menu.

Figure 19. Window menu

The Window menu includes the following selections:
Preferences

Allows you to specify general preferences, manual mapping availability view preferences, report
preferences, and hardware resolution message preferences. General preferences include the
autosave interval and preferred temporary file location. Availability preferences allow selection of the
default manual mapping view. Report preferences include formatting items; such as page size and
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margins. Hardware resolution preferences include an option to disable adapter insufficient hardware
pop-up messages.

Reset to Default Layout
After you have closed or minimized one or more of the tabbed areas (in the Hardware Resolution view,
these are: Projects, Hardware Resolution, and Channel Type Summary), this restores the Channel
Path ID Availability and Mapping Tool window to its original format. (For the Hardware Resolution
view, this is a three-pane format with Projects, Hardware Resolution, and Channel Type Summary. For
other views, there may be more panes present.)

The Help menu
Figure 20 on page 18 shows the selections under the Help menu.

Figure 20. Help menu

The Help menu includes the following selections:

Help Contents
This opens the Help window, which contains HTML documentation of the CHPID Mapping Tool User's
Guide. The left pane contains a navigation tree. The right pane displays the documentation.

The left pane displays one of the following:

• Table of Contents (the default)
• Index
• Search Results
• Bookmarks

You can select what is displayed by clicking the buttons at the bottom of the pane.

The right pane displays the topic information.

Welcome Window
This selection displays the Welcome window. The Welcome window provides links to the following:

• Information about what is new in this version of the tool
• Documentation
• Frequently Asked Questions (FAQs).
• Starting a session to use the tool.

Key Assist
This selection displays a list of all the keyboard shortcut keys. 
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Figure 21. Key assist

Install or Update Features
This selection opens the Updates window. Figure 22 on page 19 shows this. Information regarding
updates is discussed in Chapter 5, “Miscellaneous tasks,” on page 43 

Figure 22. Updates window

About
This selection opens the About IBM Channel Path Availability and Mapping Tool window. 
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This window specifies the copyright information for the CHPID Mapping Tool. It also provides the
following buttons:
Installation Details

The tool opens a window with tabs:
Features

Displays the feature providers, versions, and feature IDs.
Plug-ins

Displays a table listing plug-in providers, versions, and IDs.
Configuration

Displays a text file containing configuration information. To save the text file, click Click to
Clipboard and paste it into a text editor.

OK
The tool closes the About... window.

Buttons
After you create a project in the CHPID Mapping Tool, the tool displays the Hardware Resolution view.
Figure 23 on page 20 shows this view.

Figure 23. IBM CHPID Mapping Tool window – Hardware Resolution view

The Hardware Resolution view is one of several views. You can use some of the buttons near the top of
the window to change the view; other buttons perform processing. Figure 24 on page 20 shows the
buttons near the top of the IBM Channel Path ID Availability and Mapping Tool window.

Figure 24. CHPID Mapping Tool - Top row of buttons

The buttons that are associated with changing the view are:

• Hardware Resolution
• Manual Mapping
• CU Priorities
• Preview Report
• Save Report

The following table lists the buttons and their actions and references the detailed descriptions of any
associated views.
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Table 2. Buttons and their actions

Button Explanation

Hardware Resolution After you create a project, the CHPID Mapping Tool displays the
Hardware Resolution version of the CHPID Mapping Tool window. For
convenience, this book calls this the Hardware Resolution view. You can
use this button to restore the Hardware Resolution view after you have
switched to a different view.

For an introduction to the Hardware Resolution view, see Chapter 4,
“Performing hardware resolution,” on page 29. For detailed
information about the Hardware Resolution view, see“Performing
hardware resolution” on page 33.

CU Priorities This button displays the Priority Editing (CU) version of the CHPID
Mapping Tool window, which, for convenience, this book calls the CU
Priorities.

You need to assign priorities only in the following cases:

• If you have two (or more) control units you want the tool to process at
the same time

• If you want to prioritize the most important control units.

For more detailed information, see “The CU Priorities view” on page
63.

Manual Mapping By default this button displays the Connection Mapping (Hardware)
version of the CHPID Mapping Tool window, which, for convenience, this
book calls the Manual Mapping view. The Manual Mapping view has two
formats:

• The Hardware > I/O format
• The I/O > Hardware format.

Clicking the button displays the Hardware > I/O format. Clicking the
down-arrow beside the button allows you to choose your preferred
format.

For detailed information about the Manual Mapping view, see “The
Manual Mapping view” on page 85.

Automatic Mapping This button performs processing for automatic mapping (and also for
processing intersections), but it but does not display a different view.
For detailed information about Automatic Mapping, see “Performing
Automatic Mapping” on page 75

Process Intersections This button performs processing, but it does not display a different
view. It displays information about intersection in the CHPID Groups
pane of the CU Priorities view or Manual Mapping view (either format).
For more detailed information, see “Optionally using Process
Intersections” on page 83.

Preview Report You need to click the down arrow beside either of these buttons to
specify the type of report you want to preview or save. The tool
performs processing, then displays the Reports version of the CHPID
Mapping Tool window, which, for convenience, this book calls Report
view. For detailed information, see “The Report view” on page 102.

Save Report
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Views
After you create a project, the CHPID Mapping Tool displays the Hardware Resolution view. Figure 25 on
page 22 shows this view. 

Figure 25. IBM CHPID Mapping Tool window – Hardware Resolution view

The CHPID Mapping Tool includes the following views:

• Hardware Resolution view – pictured in the preceding; see Chapter 4, “Performing hardware
resolution,” on page 29 for more information.

• Manual Mapping view – see Chapter 8, “Manual mapping,” on page 85.
• CU Priorities view – see “The CU Priorities view” on page 63.
• Reports view – see “The Report view” on page 102.

You can switch views by clicking some of the buttons (Preview Report, and so forth) near the top of the
window; see “Buttons” on page 20 for details.

The sections that follow describe the tabbed panes within the views and the columns within some panes.
These sections tell you how to control what the tool displays.

Tabbed Panes
Each view is composed of multiple tabbed panes. For example, as shown in Figure 25 on page 22, the
Hardware Resolution view contains three tabbed panes:

• Projects pane – by default on the left. The CHPID Mapping Tool displays the Projects pane in all views.
For detailed information, see “The Projects pane” on page 15.

• Hardware Resolution pane – by default in the middle. For detailed information, see “The Hardware
Resolution pane ” on page 29 and “Performing hardware resolution” on page 33.

• Adapter Type Summary pane – by default on the right. See “The Adapter Type Summary Pane ” on page
32 for detailed information.

The tool displays various panes in other views; this book describes these panes in the descriptions of
those views. The following table summarizes which views share a particular pane:

Table 3. Panes present in various views

Pane
Hardware
Resolution view

Manual Mapping
view (both
formats) CU Priorities view Reports view

Projects X X X X
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Table 3. Panes present in various views (continued)

Pane
Hardware
Resolution view

Manual Mapping
view (both
formats) CU Priorities view Reports view

Hardware
Resolution

X

Adapter Type
Summary

X

Columns X

I/O Config X

Hardware X

CHPID Groups X X

CU Priorities X

CU Details X

Report X

Resizing width of panes
To change the respective widths of the panes, perform the following steps:

1. Placing your cursor on the boundary between two tabbed panes until a double-headed arrow appear.
Figure 26 on page 23 shows this. 

Figure 26. Double-headed arrow indicates you can resize width of s
2. Hold the left mouse button and slide the pane left or right until the respective widths are satisfactory.

Then release the mouse button.

Note: When you are displaying views with upper and lower panes, you can use the same process to resize
the height of the panes. An example of such a view is the Manual Mapping view.

Moving panes by dragging the tabs
To rearrange the panes, click a tab and hold the left mouse button to drag the pane where you want it.

Note: To return the panes to their original view, click Window > Reset to Default Layout and OK in the
Reset to Default Layout window that opens.

Using other GUI controls to control the panes
You can use the small icons near the top of the Projects, Hardware Resolution, and Channel Type
Summary tabbed panes to perform the following tasks:

• Open a menu of actions
• Minimize a pane
• Maximize a pane.

Every pane does not have every icon. Figure 27 on page 24 shows all of the icons. 
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Figure 27. Additional GUI controls in the IBM CHPID Mapping Tool window

View Menu
This arrow icon opens an actions menu.

For information about the View Menu on the Hardware Resolution pane, see the Note in “Removing
one or more PCHIDs - Action list method ” on page 36.

Minimize icon
This icon looks like a minus sign. It minimizes the pane, removing the particular pane from view.

Maximize icon
This icon looks similar to the Windows Explorer Maximizes icon. It maximizes the pane, removing the
other pane or panes from view.

Informational icons in tables
After you create a project, the tool shows the Hardware Resolution view. Figure 28 on page 24 shows
the Hardware Resolution pane in this view. The CHPID column contains an icon in front of each CHPID
number. The bidirectional arrows icon is the I/O icon. It is a non-functional icon; clicking it does not
perform any action. It is informational, indicating I/O. 

Figure 28. Hardware Resolution pane with Xs in first column

Figure 28 on page 24 also shows that the PCHID column contains an icon front of each PCHID or AID
number. The tilted square icon is the Hardware icon. It is a non-functional icon; clicking it does not
perform any action. It is informational, indicating hardware.

Restoring minimized panes
If you minimize a pane (or maximize a pane so that the other panes are automatically minimized), a set of
two icons is displayed for each minimized pane. Figure 29 on page 24 shows this. 

Figure 29. The Restore icon and the tab-name icon

The top icon is the Restore icon. (It looks like two small diagonally positioned rectangles, and it
resembles the Internet Explorer Restore Down icon.) It restores a pane you have minimized. To restore a
pane you have previously minimized, click the Restore icon.
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The bottom icon is the tab-name icon; for example, if you minimize Projects, it is the Projects icon. (This
icon resembles the Internet Explorer Maximize icon.) The tab-name icon temporarily displays a minimized
pane on top of a currently displayed pane. It provides a quick view of a minimized pane but the pane is
displayed only until you click elsewhere in the tool or click Esc.

Note: The set of two icons is displayed for each pane you minimize. So if you minimize both Projects and
Channel Type Summary tabbed panes, two sets of two icons are displayed. If you additionally minimize
Hardware Resolution, three sets of two are displayed.

Perform one of the following steps to restore a pane that has been minimized.

• To restore a minimized pane (so that it persists), click the Restore icon (the top icon in Figure 29 on
page 24).

• To temporarily display a previously minimized pane on top of another pane, click the tab-name icon (the
bottom icon in Figure 29 on page 24).

Restoring the default view after closing a pane
If you close a pane or panes in a view, such as the Hardware Resolution View, you can restore the original
view by clicking Window > Reset to Default Layout. 

Note: If you change to another view, such as the CU Priority view or the Manual Mapping view, you can
restore the Hardware Resolution view by clicking the Hardware Resolution button.

Search field
Only two views (Manual Mapping and CU Priorities) include the search field. See Figure 85 on page 69.

Columns
In panes with columns of information, such as the Hardware Resolution pane of the Hardware Resolution
frame, you can:

• Sort the information in a column – see “Sorting information” on page 25.
• Reorder the columns – see “Reordering columns within a pane” on page 27.
• (In some views) specify the columns to display.

Sorting information
For panes that contain information in tables, you can sort the columns. To sort the information in a
column, click a column heading.

By default, one column heading in each table includes an arrow. By default, the tool sorts each pane by
the column with the arrow. The arrow points up indicating the sort is in ascending order by default. For
example, in the Hardware Resolution view, by default the Hardware Resolution pane contains an arrow in
the CHPID column. This column is sorted in ascending order. Figure 30 on page 26 shows this: 
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Figure 30. Sorting by CHPID column - in ascending order

If you click the column heading (or the arrow in the column containing it), the tool displays an arrow
pointing in the opposite direction and sorts the information in descending order. Figure 31 on page 26
shows this: 

Figure 31. Sorting by CHPID column - in descending order

You can toggle back and forth between ascending and descending order by clicking the column name or
the arrow.

To change the column by which the tool sorts tabular information, click the column heading of a different
column. Figure 32 on page 26 shows the Hardware Resolution pane after the user completed hardware
resolution and then clicked the Channel Type heading. The tool displays an arrow in the Channel Type
heading and sorts the column in ascending order. 

Figure 32. Sorting by a different column
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Clicking the column heading again or clicking the arrow sorts the information in descending order.

Reordering columns within a pane
You can reorder the columns within a pane: Click the column header while holding down the left mouse
button and without releasing it drag and drop the column where you want it. The following example
shows the IOCP Type column moved to the right of the Adapter Type column. Figure 33 on page 27
shows this. 

Figure 33. Moving columns

See “Using other GUI controls to control the panes” on page 23 and “Moving panes by dragging the tabs”
on page 23 for information about manipulating and moving panes.

Controlling the display of columns
Although it is not present in the Hardware Resolution view, some other views include a Columns pane.
Figure 34 on page 27 shows this. 

Figure 34. Columns pane showing available columns for Hardware pane

When you click within a pane in the view that contains columns of information, the Columns pane reflects
the column headings. You can hide a column by clearing its check box and undo this by selecting it again.
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Chapter 4. Performing hardware resolution

This chapter:

• Explains the need for hardware resolution
• Describes the Hardware Resolution view (two formats)
• Lists the steps for performing hardware resolution.

Why is hardware resolution needed?
Some CHPID types can be used for multiple card types. For example, a CHPID type OSD can be used on
different card types -- Gigabit Ethernet or Fast Ethernet. If your project includes CHPID types that can be
used for multiple card types, you need to choose the channel type in hardware resolution.

Hardware resolution might be needed for the following reasons:

• The PCHID channel type changed from your old system to your new system
• A defined PCHID is not compatible with the channel type at a particular location
• There are not enough ports (There is not sufficient hardware)
• There is a type mismatch between a CHPID and its associated channel type.

To resolve hardware resolution issues, you might need to obtain additional hardware or use a different
IOCP file.

The Hardware Resolution view
After you load your CFReport file and IOCP input file in the CHPID Mapping Tool, the IBM CHPID Mapping
Tool window displays the Hardware Resolution view. (You can switch to other views by clicking the
buttons (Preview Report and so on) near the top of the window; see “Buttons” on page 20 for more
information.) The Hardware Resolution view includes three tabbed panes. Figure 35 on page 29 shows
this view.

Figure 35. IBM CHPID Mapping Tool window - Hardware Resolution

The Hardware Resolution pane
By default, the Hardware Resolution pane is the middle tabbed pane in the Hardware Resolution view.
Figure 36 on page 30 shows this window.
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Figure 36. Hardware Resolution

Note: For information about sorting tabular information, see “Sorting information” on page 25.

The Hardware Resolution pane contains a table with the following columns:
(Check mark, exclamation point, or X)

This column contains either an X in a red circle, an exclamation point in a yellow circle, or a green
check mark. 

Figure 36 on page 30 shows the Hardware Resolution pane with green check marks in the first column
of every row. A green check mark indicates the tool successfully resolved the specified Adapter Type.
You can unassign the PCHID or change the adapter type, but you are not required to do so.

Figure 37 on page 30 shows the pane with Xs in red circles in the first column. . 

Figure 37. Hardware Resolution pane with Xs in first column

An X in a red circle indicates an error. The Status column provides information about the nature of this
error. For example, if there are more CHPIDs, FIDs, or AIDs defined than available hardware, the
Status column contains the message: Error: No hardware found.

An exclamation point in a yellow circle indicates a warning or informational information. The Status
column provides information about the nature of the warning. For example, if there is only one
channel type available, the Status column contains the message: Attention: Only available
channel type FICON EXP8 10KM automatically selected.

Figure 38 on page 31 shows the Hardware Resolution pane with green check marks in the first
column of every row. A green check mark indicates the tool successfully resolved the specified
Channel Type.
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Figure 38. Hardware Resolution pane - With green check marks in every row

The left- and right-facing arrow icons simply indicate input and output; they are not functional.

CHPID
This column specifies the CHPID number.

Note: The I/O icon (bidirectional arrows) in front of each CHPID number does not perform any action;
it is for information purposes only.

IOCP Type
This column specifies the CHPID type.

Assigned By
This column specifies the source of the CHPID assignment. Values can include the following sources:

• Manual
• Automatic
• IOCP
• Config file
• Ignore
• Delete

For detailed information, see the Assigned By row in Table 6 on page 89.

Note: For a spanned CHPID, the value can be Multiple, and expanding the row displays individual
values as in the preceding list.

Adapter Type
This column specifies the type of card containing the port.

PCHID
This column represents the CHPID that is mapped to a PCHID. It is blank if unmapped.

Note: The Hardware icon (tilted square) in front of each PCHID number in Figure 37 on page 30 does
not perform any action; it is for information purposes only.

Status
If there is an X in a red circle in first column indicating a hardware error, the Status column provides
information about the nature of the error, such as: No hardware found. If there is a green check
mark in the first column, the Status column may be blank or it may contain information, for example
for an MES. (See Table 4 on page 34 for a list of status messages and suggestions about how to
resolve errors.)
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You do the work to perform hardware resolution in the Hardware Resolution pane. However, the
rightmost tabbed pane, Adapter Type Summary, contains helpful information. It summarizes the number
of used and available channels for the hardware adapter types.

The Adapter Type Summary Pane

By default, the Adapter Type Summary pane is the rightmost tabbed pane in the Hardware Resolution
view. Figure 39 on page 32 shows this pane.

Figure 39. Channel Type Summary pane

Note: For information about sorting tabular information, see “Sorting information” on page 25.

The Adapter Type Summary pane displays a table with the following columns:
(Blank or X in red circle)

This column either is blank or contains an X in a red circle. An X indicates the value in the Used
column is greater than the value in the Available column. This means there is not sufficient hardware
to handle the CHPIDs assigned in the IOCP file. Figure 39 on page 32 shows an example in which the
first column is blank. Figure 40 on page 32 shows an example in which the first column includes Xs: 

Figure 40. Adapter Type Summary pane with row with Xs in first column

This picture shows the Adapter Type Summary pane with Xs in the first column.

An X indicates one of the following:
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• An IOCP type that has no hardware defined for it or more attempted assignments than available. (If
there is no hardware defined, the Available column contains 0. For more attempted assignments,
the number in the Used column exceed that in the Available column.)

• A type named that is invalid for that configuration. (For example, if you have an IOCP that has FICON
and OSA, but the hardware has only FICON, the tool flags each OSA type with an X.)

In the first case, there is not enough hardware to handle the CHPIDs assigned in the IOCP input file.

Adapter Type
This column indicates the adapter type whose information is listed in the next two columns.

Used
This column specifies how many of the particular adapter type are assigned (of the total available).

Available
This column specifies how many of the particular adapter type are available.

Clicking the column heading sorts the column in descending order. If you click again, the tool
performs the sort and changes the direction of the arrow. You can click the arrow (which is pointing
up) to sort the column in ascending order. For details about sorting, see “Sorting information” on page
25

Device Count
The column lists the number of cards for each particular adapter type.

Performing hardware resolution
An X in a red circle in the first column of the Hardware Resolution pane indicates a hardware resolution
problem. Table 4 on page 34 lists the possible Status messages, their explanations, and actions for
resolution (if required).
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Table 4. Status messages

Status Explanation Resolution (if required)

No hardware found AID values or PCHID values
are present that are not found
in the hardware. This situation
could occur when you are
replacing hardware for an MES
and the IOCP file contains a
PCHID value for the old
hardware. (The IOCP file
contains a PCHID value for the
hardware being removed.)

If you have any CHPIDs of IOCP type CIB or
CS5, the CHPID Mapping Tool cannot
automatically assign these CHPIDs. If the AID
assignment in the IOCP file is not valid, you can
reset it during hardware resolution. You can
then use manual mapping to assign the CHPIDs
to AIDs.

Perform the following steps for CIB and CS5
CHPIDs:

1. Remove the AID values. To do so, see
“Performing hardware resolution to remove
PCHIDs” on page 35.

2. Do one of the following:

• Inside the CHPID Mapping Tool, perform
manual mapping to associate these
CHPIDs with AIDs. See “Performing
manual mapping” on page 93.

• Assign the AID values outside the tool, for
example, using hardware configuration
definition (HCD). Replace the IOCP file;
see Steps “2” on page 45-“4” on page
46.

Used IOCP types or adapter
types exceed the number
available. If there are more
IOCP types than available, the
Adapter Type (in the Hardware
Resolution pane) might be
empty. If there are more used
than available adapter types,
the tool indicates this
deficiency in the Adapter Type
Summary pane, in the Used
and Available columns.

You need to do one of the following:

• Change the IOCP file
• Purchase additional hardware.
• Ignore the CHPID. To do so, see “Performing

hardware resolution for over defined CHPIDs”
on page 40

Select at least one
adapter type. 

A adapter type is not assigned
to the current row.

Assign a adapter type to IOCP type. See
“Performing hardware resolution for a type
mismatch” on page 38.

Adapter_type is not
compatible with
IOCP_type.

Adapter type assigned for the
CHPID is not compatible with
the IOCP type specified by the
IOCP file.

See “Performing hardware resolution for a type
mismatch” on page 38.

Required hardware
for type IOCP_type
not available. 

Example: Required
hardware for
type FC not
available.

The CHPID Mapping Tool
found no hardware for the
specified IOCP type.

You need to change the IOCP file or obtain
additional hardware
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Table 4. Status messages (continued)

Status Explanation Resolution (if required)

PCHID_1 moved to
new channel ID:
PCHID_2

Example:

520 moved to 1E2

You are replacing hardware for
an MES, and the IOCP file
contains a PCHID value for the
old hardware, which is being
removed. This PCHID value
has moved from an old
machine to the PCHID value
for the new hardware .
PCHID_1 is the first PCHID
value (for example, 520) and
PCHID_2 is the second PCHID
value (for example, 1E2).

This status is an informational message; no
hardware resolution is required. The message
informs you of the new location so you can
change this if you prefer a different assignment.

Performing hardware resolution to remove PCHIDs

Removing a PCHID disassociates the PCHID from the CHPID.

Removing a single PCHID – PCHID column method

To remove the PCHID for a single CHPID: double click in the PCHID column of the target row. Figure 41 on
page 35 shows the Hardware Resolution pane before double clicking in the PCHID column of the first
row. 

Figure 41. Hardware Resolution pane before performing hardware resolution

Figure 42 on page 36 shows the results of clicking in the PCHID column of the first row. The tool makes
the following changes:

• Changes the X in a red circle to a green check mark.
• Removes the information from the PCHID column.
• Removes the information describing the problem in the Status column.
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Figure 42. PCHID is removed from PCHID column in target row

Note: If the IOCP file contains an error, for example a CHPID line contains FCX rather than FC, double
clicking in the PCHID column of this row displays the following error message: 

Figure 43. Hardware resolution error message

Removing one or more PCHIDs - Action list method

Perform the following steps to remove one or more PCHIDs:

1. If you are removing PCHIDs for one or more CHPIDs, click the row to select the CHPIDs to remove
holding down the Ctrl key if you are selecting multiple CHPIDs.

2. Right-click in the Hardware Resolution tabbed pane (anywhere except in the Channel Type column).
The tool displays an action menu. Figure 44 on page 36 shows an example of this menu. 

Figure 44. Right-click displays list of actions

The list of actions is dynamic, depending on the context. The choices are explained in the information
that follows.

Note: Alternately, you can click View Menu icon, which is the arrow across to the right ofRerun
Hardware Resolution. The choices that the tool displays are the same as for right-clicking.

3. Do one of the following:

• To remove the selected PCHIDs, select Reset Current Selection. 

The tool performs the following actions:

– Replaces the X in a red circle with a green check mark.
– Removes the information from the PCHID column.
– Removes the information describing the problem in the Status column.

Figure 45 on page 37 shows these changes for the last row.
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Figure 45. Results of clicking Reset Current Selection

Note: This method works for an IOCP Type of CIB (the Channel Type is IFB link) and CS5 (the
Channel Type is PCIe). However, if you click Reset Current Selection for an IOCP type of FC, you
receive the following message:

Error: Select at least one adapter type.

Use the steps under “Performing hardware resolution for a type mismatch” on page 38 to perform
hardware resolution for this situation.

• For other methods to remove multiple PCHIDs, select one of the following choices:
Reset "No hardware found" Entries

Removes the PCHID values for only those rows with an X in a red circle in the first column and a
value of Error: No hardware found in the Status column. (An X in a red circle indicates an
error, and the Status column provides information about the nature of the error.) You are
recommended to select this action.

Reset Incompatible (Hardware - I/O) Entries
Removes the PCHID values for rows whose channel type is not compatible with the IOCP type.
The Status column provides specifics. Here are some examples of the types of messages the tool
might display in the Status column:
Crypto Exp2 is not compatible with OSD

The Crypto Express2 channel type is not compatible with an IOCP type of OSD.
ESCON is not compatible with FC

The ESCON channel type is not compatible with an IOCP type of FC.
FICON EXP4 4KM LX is not compatible with FCV

The FICON Express4 4KM LX is not compatible with IOCP type of FCV.
OSA-E2 GbE SX is not compatible with FC

The OSA-E2 GbE SX channel type is not compatible with an IOCP type of FC.
OSA-E2 GbE SX is not compatible with FCV

The OSA-E2 GbE SX channel type is not compatible with an IOCP type of FCV.

Reset All
Removes all PCHID values (in both rows with Xs in red circles and rows with green check marks).
The action is the same as if you selected all of the three previously described choices. You are
not recommended to select this action.

Note:

If you select Reset All, the tool displays the following message: 
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Figure 46. Message window

To confirm you want to continue, you need to click OK.

Performing hardware resolution for a type mismatch

A type mismatch occurs in two situations:

• When you are performing an MES and the channel type in the base does not match the type in the MES.
In this case, the IOCP input file contains a PCHID value for the old hardware. For example, suppose you
OSD CHPID assigned to a 1000BaseT PCHID in the old machine and that PCHID is now an OSA
Express3 in the new machine. They are compatible but might not support the same functions. For this
type of mismatch, you might receive the following message:

Figure 47. CHPIDs with PCHID conflict
• When the associated channel type is not appropriate for a PCHID, you must resolve this by resetting the

PCHID. For example, suppose the IOCP type is FC but the PCHID is associated with an ESCON card. You
cannot assign the FC type to the ESCON card. For this kind of mismatch, you might receive the following
message.

 Adapter_type is not compatible with IOCP_type

Adapter_type
Is ESCON, FICON, and so on.

IOCP_type
Is FC, CIB, and so on.

(The information that follows concerns this kind of mismatch.)
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A first optional step for resolving a type mismatch is to reset the PCHID by removing it. “Performing
hardware resolution to remove PCHIDs” on page 35 describes how to reset the PCHID by removing it.

Perform the following steps to fix a type mismatch:

1. In the target row, click in the Adapter Type column.

The tool displays an arrow in the Adapter Type column of the target row. Figure 48 on page 39
shows a row with the arrow.

Figure 48. Arrow in Adapter Type column
2. Click the arrow. The tool displays a list of available card types for the CHPID. Figure 49 on page 39

shows a list. The tool displays only types that are compatible for the CHPID. 

Figure 49. Adapter types list
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Note: There might be only one selection in the list – the selection that already appears in the Adapter
Type column for that row. In this case you cannot change the assigned channel type to eliminate a
problem. You need to purchase additional hardware.

3. Select the card type from the list.

The tool makes the following changes:

• Replaces the X in a red circle with a green check mark
• Displays the type you selected in the Adapter Type column
• Removes the message in the Status column.

Figure 50. Results of selecting a channel type

Performing hardware resolution for over defined CHPIDs
Over defined CHPIDs occurs when the number of used IOCP type exceeds the number available.

An optimal step for handling this case is to make the CHPIDs as Ignore.

Perform the following steps to accomplish this:

1. Select the CHPID rows you would like to ignore holding down the Ctrl key if you are selecting multiple
CHPIDs.

2. Right-click in the Hardware Resolution tabbed pane (anywhere except in the Adapter Type column).
The tool displays an action menu. Figure 51 on page 40 shows an example of this menu.

Figure 51. Right-click displays list of actions
3. Select Ignore CHPID or Delete CHPID.

Note: The Delete CHPID will delete the CHPID from the Export IOCP files.

Resetting hardware resolution changes
After you successfully perform hardware resolution, all the rows in the table in the Hardware Resolution
pane have green check marks in the first column or exclamation points in yellow circles in the first
column.Figure 52 on page 41 shows this.

40  IBM Z: CHPID Mapping Tool User's Guide



Figure 52. Hardware Resolution pane after hardware resolution

If you need to reset your hardware resolution changes, perform the following steps:

1. Click Rerun Hardware Resolution, which is across from the Hardware Resolution tab.

The Hardware Resolution window opens: This window indicates that continuing resets the changes.
2. If you want to change back the values in the Adapter Types column, click Yes. This resets the values

as if you had reloaded the IOCP file.

Figure 53 on page 41 shows this.

Figure 53. Hardware resolution is reset

Hardware resolution problems and solutions
The following table lists some hardware resolution problems and possible solutions:

Table 5. Hardware resolution problems and actions

Problem Actions

Insufficient hardware Buy additional hardware or load a different IOCP
input file.

The IOCP input file could contain channel
definitions for adapter types that are not part of the
new machine configuration.

Modify or remove those definitions in the IOCP.
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Table 5. Hardware resolution problems and actions (continued)

Problem Actions

There might be more adapter defined or implied
than the machine can support. For example, if a
machine is fully configured with the maximum
number of CHPIDs, any definitions in the IOCP for
internal coupling links cause the input to fail.

Remove adapters that are higher in number than
the total number that the machine supports. You
can see this information in the Adapter Type
Summary pane of the Hardware Resolution view.

The IOCP input file could contain errors. For
example, someone could edit a file to remove
some of the channel definitions but fail to delete
the control unit definitions referencing those
channels. The source input must be accurate, and
HCD must generate it or IOCP must verify it.

Replace the IOCP input file. Ensure that the IOCP
input file is accurate by using an IOCP file that
hardware configuration definition (HCD) generated
or that IOCP verified.

Note: The IOCP input file you provide to the tool by
the direct output of HCD or IOCP must verify the
input. The IOCP definitions must be output directly
from a version of HCD/HCM that supports the
system, or the appropriate level of ICP IOCP must
verify it before you load it into the tool.

The IOCP input file might have become corrupted
during editing or during a file transfer. Some
characters could be dropped or the asterisks (*)
used for continuation indicators could be in the
wrong column. The source file must be accurate
and adhere to the syntax rules of IOCP.

Replace the IOCP input file. Ensure that the IOCP
input file is accurate by using an IOCP file that
hardware configuration definition (HCD) generated
or that IOCP verified.

Note: The IOCP input file you provide to the tool by
the direct output of HCD or IOCP must verify the
input. The IOCP definitions must be output directly
from a version of HCD/HCM that supports the
system, or the appropriate level of ICP IOCP must
verify it before you load it into the tool.
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Chapter 5. Miscellaneous tasks

This chapter includes information about how to perform various tasks. The tasks are mainly grouped
according to how you access them.

• Performing tasks in the projects pane:

– Creating a new project. See “Creating and working with multiple projects ” on page 43.
– Importing a deleted project. See “Importing a deleted project” on page 45.
– Importing a different IOCP file. See “Importing the IOCP file” on page 45

• Setting Preferences. See “Setting Preferences” on page 46.
• Saving session information.

– Saving an unnamed session. See “Saving a session” on page 48.
– Exporting a named session. See “Exporting an IOCP input file” on page 51.

• Restoring a saved session. See “Importing a saved session” on page 49.
• Exporting an updated IOCP file. See “Exporting an IOCP input file” on page 51.

Tasks accessed in the Projects pane
You have already used the Projects pane to create a project. See “Creating a project” on page 9 for
details. You can perform additional tasks in the Projects pane.

Perform the following steps to perform an additional task in the Projects pane:

1. Make sure the project name of the target project is the one that is highlighted in the Projects pane.
2. Right-click in the Projects pane. This action displays a menu. Figure 54 on page 43 shows this menu. 

Figure 54. Right clicking displays actions
3. Click an action to perform a task. The sections that follow describe performing specific tasks.

Creating and working with multiple projects
You have already created a project; see “Creating a project” on page 9. However, the CHPID Mapping Tool
allows you to create multiple projects and to display information about the project you choose.

To create a new project, perform the steps under “Creating a project” on page 9.
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Figure 55 on page 44 shows the Projects pane with two projects. 

Figure 55. Projects pane with two projects

The contents of the panes other than the Projects pane depend on which project you select as active. You
can switch back and forth between multiple projects by selecting the one you want active.

Switching to a different project

Perform the following steps to switch to a different project.

1. In the Projects pane, double-click the name of the project you want to view. If you have made any
changes to the information in the project you are exiting, the tool saves the changes before loading the
other project. The tool displays the progress of saving the project in the bottom right corner of the
window.

Figure 56. Progress indicator for saving a project

After saving, the tool displays the Load Project window.Figure 57 on page 44 shows this window. 

Figure 57. Load Project indicator window

Deleting a project
Perform the following steps to delete a project:

Note: Verify the project you want to delete is selected in the Projects pane.

1. Right-click in the Projects pane.
2. Click: Delete.

The tool opens the Confirm Projects Delete window. Figure 58 on page 45 shows this window.
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Figure 58. Confirm Project Delete window
3. Optionally, to delete the project_name folder (under the workspace folder) click Also delete contents

under path. By default, the tool selects Do not delete contents.
4. Click Yes to delete the project.

Importing a deleted project
If you selected Do not delete contents when deleting a project, you can import the contents back.

Perform the following steps to import a deleted project:

1. Right-click in the Project's pane.
2. Click New > Standard CMT Project.
3. Type the name of the deleted project. The tool detects the project automatically.
4. Click Finish to load the deleted project.

Importing the IOCP file
If you have not imported an IOCP input file when creating a project, you can do so later.

Perform the following steps to import an IOCP input file:

1. Right-click in the Projects pane.
2. Click Import IOCP File. The tool opens the window where you specify the IOCP file. Figure 59 on page

46 shows this window. 
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Figure 59. Window for specifying IOCP file
3. Do one of the following:

• Type the IOCP input file path and name in the IOCP input file field.
• Click Browse, and navigate to the IOCP input file you want to use and select it. Click Open.

4. Click Finish. This loads the IOCP input file.

After loading the IOCP input file, you must right click on the new file (located in the input folder), and
select Read Selected IOCP if you would like to make this the active IOCP input file for the project.

Setting Preferences
The CHPID Mapping Tool allows you to set several types of preferences.

General Preferences include the following items:
Temporary folder location

The directory where files are located until the tool saves session information.
Autosave interval

The amount of time between automatic saves that the tool performs. The default is 5 minutes.

Report preferences include items such as page and margin sizes. Availability preferences allow selection
of the default manual mapping view. Hardware resolution preferences include an option to disable
adapter insufficient hardware pop-up messages.

Perform the following steps to view or change preferences:

1. Click Window > Preferences. The tool displays the Preferences window. Figure 60 on page 47 shows
this page. 
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Figure 60. The General Preferences page of the Preferences window
2. Ensure the Preference page you want is selected in the navigation tree on the left. Figure 61 on page

47 and Figure 62 on page 48 shows the Preferences window with the Hardware Resolution
Preferences and Report Preferences pages selected.

The Hardware Resolution Preferences page allows you to turn off pop-up messages when running
hardware resolution.

Figure 61. The Hardware Resolution Preferences page of the Preferences
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Figure 62. The Report Preferences page of the Preferences window
3. Make any changes you want. When you are done making changes on a page, click Apply to save your

changes but keep the Preferences window open or click OK to save your changes and close the
Preferences window.

Saving a session
The CHPID Mapping Tool automatically saves your session every n minutes, depending on the value you
have set in preferences. By default, this value is 5 minutes. The tool also saves your session before
exiting.

Perform the following steps to save session information: Click File > Save Session. Figure 63 on page 48

Figure 63. The File and Save Session selections

Exporting sessions
You might need to export session information to send project data to someone working on the same
project or to provide problem information to IBM Support. (See “Importing a saved session” on page 49
for details on using the received project data.) Exporting a session zips up the following files and folders:

• Input folder

– CFReport folder - contains CFReport file
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– IOCP folder - contains IOCP file
• Reports folder
• The session.cmt.edat file

The tool exports these items into a file whose name you specify. It appends the extension .cmt.edat to
the exported file. (The e in edat stands for export.)

Perform the following steps to export a session:

1. Click File > Export Session. The tool opens the Export Session window. Figure 64 on page 49 shows
this window. 

Figure 64. Export Session window
2. Select the project name in the Projects field.
3. Complete the Export path field.

You can type the path in the field. Alternately, you can click Browse, navigate to the folder and select
it, and click OK.

Note: Use a directory other than the Workspace directory.
4. Click Finish. The tool saves the .cmt.edat file in the folder you specified.

Importing a saved session
You can import a session that has been exported. (See “Exporting sessions” on page 48 for information
about exporting a session.)

Perform the following steps to import an exported session:

1. Click File > Import Session. This tool opens the Import CMT Project window. Figure 65 on page 50
shows this window. 
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Figure 65. Import CMT Project window

step opens the a window where you select the session file you want to import.
2. Type the full path of the archive file in the Archive name field or use Browse and navigate to the file,

select it, and click Open. The tool fills in the Session name based upon the file you specify.
3. Click Finish.

Note:

a. When exporting a session, the tool zips the Input folder (with folders containing IOCP and
CFReport files), Reports folder, and session.cmt.dat file into a file with an extension
of .cmt.edat. When importing a session, the tool unpacks these files. Figure 66 on page 51
shows an example in which the session to import has a file name of ABC Project.cmt.edat. The
tool fills in the Session name of ABC Project. 
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Figure 66. Importing a File

After the user clicks Finish, the project, named ABC Project, is included in the Projects pane. The
project includes the Input folder (with folders containing IOCP and CFReport files), Reports folder,
and session.cmt.dat file. Figure 67 on page 51 shows the ABC Project in the Projects pane. 

Figure 67. Project pane contains the project
b. The tool stores the project files under the project_name directory. For example, the tool saves the
session.cmt.dat file in the ABC Project folder.

Exporting an IOCP input file
This task is not available until after you have loaded an IOCP input file during project creation or
afterward.

Perform the following steps to export an IOCP input file.

1. Click File > Export IOCP.
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• If you assigned temporary AID values to CIB or CS5 CHPIDs, the tool displays a warning message
that you should manually fix these (using an editor outside the tool) before exporting the IOCP input
file. Click Cancel to abort exporting the IOCP input file or Continue.

• If you have unassigned CHPIDs, the tool displays a warning message that you should assign these
before exporting the IOCP input file. Click Cancel to abort exporting the IOCP input file or Continue.

If the tool displays no warning or you choose to continue after a warning, the tool opens the Export
IOCP input File window. Figure 68 on page 52 shows this window. 

Figure 68. Export IOCP Input File window
2. Complete the Export Path field.

You can type the path in the field. Alternately, you can click Browse, navigate to the folder and select
it, and click OK.

3. Type in the IOCP name in the IOCP Input File field.
4. After the IOCP Input File field is complete, click Finish.

Updating the tool
Before you begin: Download the update (.zip) file from Resource Link.

Perform the following steps to update the CHPID Mapping Tool program:
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1. Click Help>Install or Update Features. Figure 69 on page 53 shows these selections. 

Figure 69. Help menu includes Install or Update Features

After you make these selections, the tool opens the Select Update Location window. Figure 70 on
page 53 shows this window. 

Figure 70. The Select Update Location window
2. Complete the Path field.

a. Click Browse. The tool displays the Open window.
b. Click the appropriate file in the Open window to select it, and click Open. The tool displays the

Select Update Location window with the Path field completed.

Alternately, you can type the path and file name in the Path field to complete it.
3. Click Finish. The Search Results window displays the content found from the specified path.
4. Select CHPID mapping tool update archive and click Next.
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Figure 71. Install window - with search results from path
5. The Install window opens, displaying the licensing agreement. Figure 72 on page 55 shows this

window. 
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Figure 72. Install window - with feature licensing agreement
6. Click to select I accept the terms of the license agreement. (Selecting a radio button

makes Next available.) Click Next. The Install window displays installation information. Figure 73 on
page 56 shows an example: 
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Figure 73. Install window - with installation information
7. Click Finish. The Verification window opens. Figure 74 on page 57 shows this. 
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Figure 74. Verification window
8. Click Install. The Install/Update window opens. Figure 75 on page 57 shows this window. 

Figure 75. Install/Update window
9. Click Yes. The tool closes and reopens.

10. Click OK to clear the message. The tool reopens the CHPID Mapping Tool window.
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Chapter 6. Strategies and Guidelines for Assigning
Priorities

In manual mapping, you manually assign CHPIDs to PCHIDs. By contrast, automatic mapping allows the
CHPID Mapping Tool to map CHPIDs to PCHIDs, and the tool tries to find the optimal mapping for each
CHPID. A key step before performing automatic mapping is assigning priorities. One reason for assigning
CU priorities is that your project has two (or more) control units that need to be processed at the same
time.

The task of setting CU priorities consists of assigning priority numbers to control units. Setting CU
priorities Priority numbers represent the order in which the tool maps the control units. This order is a key
requirement of mapping for high availability.

The relationship between priority numbers and their priority (mapping order) is: The lower the priority
number, the higher the priority. For example, a control unit with a priority number of 0001 is mapped
before one with a priority number of 1000. The priority numbers correspond to the order of processing. A
lower priority number indicates a higher level of importance.

This section provides strategies and guidelines to help you assign priority numbers effectively for
effective automatic mapping.

Availability algorithm for automatic mapping
Automatic mapping configures paths to multiple path control units according to the following order of
precedence (highest to lowest):

• Book
• MBA or Fanout
• Domain
• I/O card.

The tool does not consider logical partitions (that is, which CHPIDs are assigned to what LPs), switch
configurations, or control unit availability characteristics. For these reasons, the mapping results might
not be acceptable for all users. While helpful for many, the tool cannot replace an expert system
programmer.

Use incremental numbering
The first time you specify the priorities of control units, use incremental numbering for priorities rather
than sequential numbering by ones. For example, use increments of five (0005, 0010, 0015, and so on) or
10 (0010, 0020, 0030, and so on). A single pass through the tool is unlikely to produce the mapping you
want. Using incremental numbering allows you to change the priorities of some control units without
having to redo others.

For example, suppose you start with priority 0001 and assign priorities by ones from 0001 to 0100. Then
you run the tool and discover you need to change the control unit with priority 0025 to priority 0009. You
would have to go back and redo all control units from 0009 to 0100. With incremental numbering, you
could reassign only the control unit with the problem to an unassigned priority. You would not have to
redo the priorities of other control units.
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Examine critical devices and paths and the HCD definitions
To prioritize at the control unit level, first look at the paths to critical devices, and then identify how these
devices are defined to HCD. This information includes the relationship to control units and ultimately to
channel paths. For example, Figure 76 on page 60 shows IOCP source input for a string of devices where
each individual path is defined with a single control unit statement:

Figure 76. IOCP Code i -- Each Individual path is defined with a single control unit statement

In this example, there are eight paths to the string of DASD in the address range 1000. Optimally, the
eight paths would be spread across availability boundaries to ensure high availability if one or more paths
to the devices fails. Therefore, define control units 1000, 1001, 1002, 1003, 1004, 1005, 1006, and 1007
with the same priority. (This assigns them to the same priority group.) Doing so enables the mapping tool
to understand the relationships between the control units. Defining the control units with the same
priority ensures that all eight paths are mapped for availability.

Examine relationships across different control units
Although some control units and their attached devices are physically independent, there might be a
critical relationship in terms of availability. An example is the use of 3174 control units for master and
alternate console support. Consider the following example:

CNTLUNIT CUNUMBR=1D40,PATH=(CSS(0),44),
      UNITADD=((00,016)),UNIT=3174
CNTLUNIT CUNUMBR=2D40,PATH=(CSS(0),45),
      UNITADD=((00,016)),UNIT=3174

At first glance, the control units might appear to be unrelated. However, you might know that 1D40 is the
control unit for the master consoles for a particular LPAR and that 2D40 is the control unit for the
alternate consoles of that LPAR. Because availability would be key for both of these control units, put
them in the same priority group.

You continue this analysis across different control unit types, such as 3745s, tape units, CTCs, and so on.
Typically, the customer is aware of these relationships and can plan accordingly.

CHPIDs not connected to control units
Figure 77 on page 61 shows the CU Priorities pane in the CU Priorities view. Look at the CU Number
column. At the end of the list, the CHPID Mapping Tool displays all CHPIDs defined in the IOCP input that
are not connected to control units. All coupling CHPIDs in this list are preceded with an "S". All non-
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coupling CHPIDs are preceded with a "P". In the example, Figure 77 on page 61 shows an "S" before the
CU Number.

Figure 77. "S" before CU number of a coupling CHPID

Reasons to review the list of unconnected CHPIDs include the following:

• You might have forgotten to add a CHPID to a control unit and need to update the IOCP source before
continuing in the tool.

• The unconnected CHPIDs might be extra channels you are ordering in anticipation of new control units
• The unconnected CHPIDs might be coupling links that are being used in coupling facility (CF) images.

(These do not require control units.)

If unconnected CHPIDS are extra CHPIDs for anticipated new control units, you might want to group
these CHPIDs with a common priority. Such a grouping allows automatic mapping to pick PCHIDs that
afford your new control unit good availability.

If they are coupling links used by a CF image, group these links.

Use a common priority to group each set of CHPIDs going to a different CPC. For example, suppose the CF
image has four links (CHPIDs 40, 41, 42, 43) and that 40 and 41 go to one CPC, while 42 and 43 go to a
different CPC. In this case, give CHPIDs 40 and 41 one priority and CHPIDs 42 and 43 a different priority.
The concept is the same regardless of the number of connecting CPCs or the number of links to each CPC.

Note: Different sysplexes are likely to have different levels of importance. You should consider this when
assigning the priorities.

Set priorities for daisy-chained control units
In many cases, especially when ESCON or FICON directors are used, multiple control units are daisy-
chained off the same channels either logically or physically. In this case, you do not need to prioritize all
control units. (The reason is you are simply trying to map the channels for the control units. If you map
the first one, the others are automatically mapped for availability. Therefore, assigning a priority for one of
the control units (or groups of control units) automatically brings the others along without your assigning
them priorities.)

If some daisy-chained control units have different numbers of CHPIDS going to them, separate the
control units into different groups. Doing so is advantageous from an availability perspective, even though
the same CHPIDs are being used. Assign the control units with fewer common channels as a higher
priority (lower priority number) than control units with larger numbers of common channels.
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For example, suppose control units CU1 and CU2 are daisy chained. CU1 has CHPIDs 1 and 2, while CU2
has CHPIDs 1,2,3, and 4. Assign CU1 to a priority group that is processed before the group containing
CU2 (even though all CHPIDs going to CU1 also go to CU2).

Note: When you enter a priority for a control unit and other control units use the same CHPIDs, those
entries are unavailable to indicate possible daisy chaining.

A limit applies to control units in a priority group
You can place a limited number of control units in the same priority group. The number of associated
channels determines the limit. The exact number of the limit depends on the types of channels. The limit
is a fixed value independent of the configuration. The CHPID Mapping Tool informs you if the number of
control units in the same priority group exceeds the limit.

The number of CHPIDS in a single group that can be spread across cards for availability has a physical
limit. . For example, for an IOCP with 256 ESCON channels, it might seem easiest to put all control units in
a single group. However, doing so is not feasible because the machine would need 256 separate ESCON
cards.
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Chapter 7. Assigning priorities, automatic mapping,
and processing intersections

The CHPID Tool provides two methods for mapping CHPIDs to PCHIDs:
Manual mapping

You manually assign CHPIDs to PCHIDs.
Automatic mapping

You optionally assign CU priorities and allow the tool to automatically assign CHPIDs to PCHIDs for
maximum availability.

To get the maximum benefit from the CHPID Mapping Tool, you are recommended to use automatic
mapping whenever possible. However, certain situations require you to perform manual mapping before
you can perform automatic mapping. For example, the CHPID Mapping Tool cannot automatically assign
to a PCHID any CHPID with an IOCP type of CIB or CS5. If the AID assignment in the IOCP input file is not
valid, you can reset it during Hardware Resolution (see “Performing hardware resolution to remove
PCHIDs” on page 35). Then to enable Automatic Mapping, you use manual mapping to reassign those
CHPIDs to PCHIDs.

You might also want to use manual mapping in the following circumstances:

• If you have specific requirements about how CHPIDs should be laid out on the machine.
• To make minor mapping adjustments.
• To eliminate intersections after you use Process Intersections. (See “Resetting CHPIDs in manual

mapping” on page 82.)

For details about performing manual mapping, see Chapter 8, “Manual mapping,” on page 85.

To make Automatic Mapping available, you need to do the following:

1. If you have any CHPID with an IOCP type of CIB or CS5, use manual mapping to assign each such
CHPID to a PCHID. (For manual mapping details, see Chapter 8, “Manual mapping,” on page 85.)

2. If necessary, use manual mapping to assign any other unassigned CHPID to a PCHID.
3. Optionally assign priorities.

The CU Priorities view
This button displays the CU Priorities view. This view has four panes in the IBM CHPID Mapping Tool
window. Figure 78 on page 64 shows this view.. 
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Figure 78. IBM CHPID Mapping Tool window - CU Priorities view

The view includes:
Projects

By default, this pane is on the left. (It is on the top left if there are two panes on the left.) See “The
Projects pane” on page 15for a detailed description.)

CU Priorities
By default, this pane is the center pane on the top. It is the pane where you perform the work of
assigning priorities. This pane shows the control unit numbers and types.

CHPID Groups
By default, this pane is the center pane on the bottom. This pane shows the members (CHPIDs) of the
control units and any intersections.

CU Details
By default, this pane is on the right. This pane shows the members (CHPIDs) of the control units.

Optionally assigning priorities
You might decide to assign priorities in certain situations. For example, you might assign priorities if:

• You have two (or more) control units that you want to process at the same time
• You want to prioritize control units.

Perform the following steps to assign priorities:
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1. Click CU Priorities to open the CU Priorities view if it is not already open. Figure 79 on page 65 shows
the three panes in the CU Priorities pane view. The CU Priorities pane includes a Priorities column.
Before you assign priorities, this column has " - " in each row. 

Figure 79. CU Priorities pane before assigning priorities
2. Perform this step for each row: Type a priority number for the CU in the Priority column.

Figure 80 on page 66 shows the CU Priorities pane after you have assigned all priorities.
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Figure 80. After assigning priorities

When you type in priorities, the CHPID Mapping Tool makes additional related changes in the CHPID
Groups pane.

Control Unit Group
Before you assign priorities, Control Unit Groups are the only type of group in the CHPID Groups
pane. After you assign priorities, this type of group is for control units not sharing the same priority
with other control units. Figure 80 on page 66 shows an example. In this example, in the CU
Priorities pane:

• Control unit number 8000 is the only one with a priority of 30
• Control unit number is the only one with a priority of 1.

After you assign priorities, in the CHPID Groups pane, control unit numbers 8000 and S0F4 remain
in Control Unit Groups.

Priority Group
If you assign the same priority to multiple control units, the tool lists a Priority Group in the CHPID
Groups pane. This type of group is for control units sharing the same priority. Figure 80 on page 66
shows an example. In the CU Priorities pane, three control units have the same priority:

• FFFD
• FFFE (both CSS 1 and CSS 0).

In the CHPID Groups pane, these three control units are in a Priority Group.

Figure 81 on page 67 shows the CHPID Groups pane as it appears after assigning priorities (in either
the CU Priorities pane or the Manual Mapping pane). It has the two Control Unit Groups and a Priority
Group.
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Figure 81. The CHPID Groups pane - with members not expanded

Clicking the bottom plus sign of each group (in the first column) expands the information and displays
the members belonging to the group. Figure 82 on page 67 shows this expansion:

Figure 82. The CHPID Groups pane - with members expanded
3. Click Manual Mapping. This returns you to the Manual Mapping view.

Unless you have changed the default, the CHPID Mapping Tool displays the Hardware > IO format of
the Manual Mapping view. Figure 83 on page 68 shows this format.
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Figure 83. Manual Mapping view after assigning priorities - Hardware > I/O format

Alternately, you can click the down-arrow beside Manual Mapping and click I/O > Hardware to
display the other format of the Manual Mapping view. Figure 84 on page 68 shows this format.

Figure 84. Manual Mapping view after assigning priorities -- I/O > Hardware format
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(See “Panes in the I/O -> Hardware format” on page 92 for more information.)

For an IOCP type of CIB , the adapter type is IFB Link or HCA. For an IOCP type of CS5, the
adapter type is PCIe. In the I/O > Hardware format of the Manual Mapping pane, you can view CIB
and CS5 IOCP types; Figure 84 on page 68 shows CIB IOCP types. In the Hardware > I/O format, you
can view IFB Link, HCA, or PCIe adapter types; Figure 83 on page 68 shows HCA adapter types.

For more information, see “Manually assigning CHPIDS of type CIB and CS5” on page 69.

Manually assigning CHPIDS of type CIB and CS5
If you have CHPIDs of IOCP type CIB or CS5, you must assign these CHPIDS to make Automatic Mapping
available.

Perform the following steps to make Automatic Mapping available:

1. If you have not already done so, ensure that the tool is displaying the Manual Mapping pane in the
Hardware >I/O format.

2. Find all the PCHIDs of type IFB, HCA, and PCIe by doing one of the following steps:

• Type IFB, HCA, or PCIe in the Search field near the top of the pane, (Figure 85 on page 69 shows
the search field in the Hardware pane before the search) and click Enter. 

Figure 85. Hardware pane in Manual Mapping view

Figure 86 on page 70 shows the results of the search.
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Figure 86. Results of search

Note: To reset the contents of the Hardware pane, remove the contents of the search field.
• In the Hardware pane, click the Adapter Type column header. This action sorts the column by

adapter type. Figure 87 on page 71 shows this. 
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Figure 87. Hardware pane after sorting by adapter type
3. For every row having HCA in the Adapter Type column, perform the following steps:

a. Click a row in that has a adapter type of HCA. The tool displays the CHPIDs with IOCP type of CIB
that are available. Figure 88 on page 71 shows an example: 

Figure 88. Adapter type of HCA Link and associated CIB type CHPIDs
b. Select one or more empty check boxes in the I/O Config pane to assign the CHPID or CHPIDs.

Figure 89 on page 72 shows an example of selecting a single check box.
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Figure 89. Changes in Hardware and I/O Config panes

If you select a single check box, the tool makes the following changes:

• In the Hardware pane:

– In the CHPID column, it inserts the CHPID number.
– In the Assigned By, it inserts the value Manual

• In the I/O Config pane:

– In the first column, it puts a green check mark in the check box.
– In the Assigned By, it inserts the value Manual.

Note:

1) There may be cases in which you select a single check box but the tool automatically selects
additional check boxes. This occurs because the CHPID you selected is spanned, as is its
associated CSS. Any additional CHPIDs are assigned to the same PCHID. Figure 90 on page 72
shows an example in which the user selected 0.F0 and the tool automatically selected 1.F0. 

Figure 90. Multiple check marks for a spanned CHPID after selection of a single check box
2) In the I/O Config pane, you can click Hide Spanned to hide the additional item or items. Figure

91 on page 73 shows the additional item hidden. 
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Figure 91. Results of clicking Hide Spanned
3) In the I/O Config pane, a check box might have a green square in it. This means the CHPID is

already assigned to another PCHID and you cannot select it. Figure 92 on page 73 shows an
example. CHPIDs 0.F0 and 1.F0 are already assigned. 

Figure 92. Green square inside check box means CHPID is unavailable

If you select more than one check box, the changes in the I/O Config pane are the same as for a
single selection. However, in the Hardware pane, there are several differences:

• The value in the CHPID and Assigned By columns is Multiple (rather than Manual). Figure 93
on page 74 shows Multiple in these columns. 
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Figure 93. Hardware pane displays "Multiple" in Assigned By column
• The first column of the Hardware pane has a box with a plus sign in it. Figure 94 on page 74

shows an example. 

Figure 94. Clicking + displays additional details

If you click the +, the row expands, showing all the CHPIDs. Figure 95 on page 74 shows an
example with the row expanded to show 0.F0 and 0.F1. 

Figure 95. Expanding the row to display multiple CHPIDs
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• In the expanded view of the CHPIDs, the tool displays Manual(S) in the Assigned By column for
each CHPID. Manual indicates the you assigned the CHPID manually. The (S) indicates the
CHPID and its associated CSS are spanned.

After you assign all the CHPIDs of IOCP type CIB and CS5, you will be able to perform Automatic
Mapping.

Performing Automatic Mapping

Figure 96. Automatic Mapping

Clicking Automatic Mapping performs two tasks:

• It performs the processing for automatic mapping
• It processes intersections.

Note: Although Automatic mapping includes processing intersections, there may be times when you want
to process intersections without the overhead of performing automatic mapping. (See “Optionally using
Process Intersections” on page 83 for such situations.)

Most of the processing that Automatic Mapping performs is not apparent to the user. The only part that
the user sees when the tool asks the user to indicate which CHPID assignments to reset (and a progress
bar window for mapping and processing intersections).

Perform the following steps for automatic mapping.

1. Click Automatic Mapping.

The Reset CHPID Assignments window opens. Figure 97 on page 76 shows an example of the
window with four choices. The fourth choice, is available only for an upgrade or an MES.
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Figure 97. Reset CHPID Assignments window
2. Select the CHPIDs you want to reset.

You can select none, all, or any number of check boxes.

Note: None of the choices affects CIB or CS5 type CHPIDs associated with IFB Link, HCA, or PCIe
channel types.

Reset CHPIDs assigned by Automatic Mapping
Resets all CHPIDs processed by previous automatic mapping in this session.

By default, this option is selected. (To select none of the options, clear this default selection or
click Deselect All.)

Reset CHPIDs assigned by Manual Mapping
Resets CHPIDS for which manual mapping assigned PCHIDs.

Reset CHPIDs assigned by IOCP
Resets CHPIDS assigned in the IOCP input file.

Selecting this option may require recabling after automatic mapping. The following message is
displayed (in red on the Reset CHPID Assignments window): 

Resetting IOCP assignments may require recabling

Reset CHPIDs assigned by CMT for config files
Resets assignments the CHPID Mapping Tool made (for an upgrade or an MES). The tool resets the
assignments only if the project's IOCP file includes CHPID Mapping Tool assignments for config
files.

Recommendation: Even if Reset CHPIDs assigned by CMT for config files is available, you are
recommended not to select it. Suppose you run automatic mapping and review the intersections,
concluding that the configuration file assignments are causing unacceptable intersections. You are
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then recommended to use manual mapping to reset only those configuration file assignments
causing the unacceptable intersections.

3. Click OK.

After the tool completes processing, you can view any intersections in the CHPID Groups pane of Manual
Mapping or CU Priorities view.

Intersections
The next several sections provide the following information:

• Types of intersections
• Viewing information about intersections
• Possible strategies for eliminating intersections
• Manually running Process Intersections.

Types of Intersections
The CHPID Mapping Tool flags several types of intersections. An intersection indicates a possible
availability problem that you might need to consider and correct. The types of intersections are:

D
Assigned pchids are on the same daughter card.

C
Two or more assigned pchids use the same adapter card.

S
Greater than half the assigned pchids use the same InfiniBand or STI link.

M
All the assigned pchids are supported by the same MBA group.

B
Greater than half the assigned pchids are connected to the same book.

Viewing information about intersections
After you run Automatic Mapping (or Process Intersections – see “Optionally using Process
Intersections” on page 83) the tool displays information about intersections in the CHPID Groups pane.
(This pane is present in the Manual Mapping view (both formats) and in the CU Priorities view.) Figure 98
on page 78 shows an example in which the tool flags "C" or "Card" intersections. The tool displays a red
"C" in the Type column and "Card" in the Data column.
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Figure 98. The CHPID Groups pane flags intersections

Displaying only intersections
To display only the intersections in the CHPID Groups pane, click Show Intersects. To display all of the
groups again, click Show Intersects again.

Filtering information about intersections
Perform the following steps to filter information about intersections.

1. If you have not already done so, open the Manual Mapping view in the I/O Config > Hardware format.
(Click the arrow beside Manual Mapping, and then click I/O > Hardware.) Figure 99 on page 78
shows format. 

Figure 99. Manual Mapping view in I/O Config > Hardware format
2. In the CHPID Groups pane (at the bottom right by default), double click on Control Unit Group or

on the intersection information (in Figure 99 on page 78, this is a big red C). This filters the information
that the tool displays in the I/O Config pane. Figure 100 on page 79 shows this. 
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Figure 100. Filtered information in the I/O Config pane
3. If you want to undo filtering, click Remove Filtering in the CHPID Groups pane. This returns the I/O

Config pane to its previous state. Figure 101 on page 79 shows this. 

Figure 101. Removing filtering

Resolving Intersections
You can try to resolve intersections by:

• Resetting priorities in the CU Priorities view
• Changing assignments in the Manual Mapping view
• Using a different IOCP file
• Adding hardware.

Resetting priorities to resolve intersections

Perform the following steps to reset priorities:

1. If you have not already done so, display the CU Priorities view by clicking CU Priorities. Figure 102 on
page 80 shows the originally assigned priorities and four associated intersections. 
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Figure 102. Original priorities and associated intersections
2. In the CU Priorities pane, change the priority of any control unit that has an intersection and has the

same priority as another control unit. Figure 103 on page 81 shows the updated priorities. 

80  IBM Z: CHPID Mapping Tool User's Guide



Figure 103. Updated priorities
3. Click Automatic Mapping or Process Intersections.

Note: (As previously noted, Automatic Mapping includes processing intersections. However there
may be times when you want to process intersections without the overhead of performing automatic
mapping. See “Optionally using Process Intersections” on page 83for more information.)

Figure 104 on page 82 shows only two "C" intersections (after changing a priority) rather than the
original four.

Chapter 7. Assigning priorities, automatic mapping, and processing intersections  81



Figure 104. Intersections reduced

• Use manual mapping to remap CHPIDs to PCHIDs to fix intersections:

Resetting CHPIDs in manual mapping

Perform the following steps to reset CHPIDS using manual mapping:

1. If you have not already done so, open the Manual Mapping view in the I/O Config > Hardware format.
Figure 105 on page 83 shows this. 
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Figure 105. Manual Mapping view in I/O Config > Hardware format

Note: The CHPID Groups pane displays any intersections. This pane is present in the CU Priorities view
and in both formats of the Manual Mapping view.

2. Optionally, filter groups; see “Filtering information about intersections” on page 78 for details.
3. See “Undoing a manual mapping assignment” on page 97and “Performing manual mapping” on page

93for information about remapping CHPIDs in the Manual Mapping view.
4. Click Automatic Mapping or Process Intersections (see “Optionally using Process Intersections” on

page 83) to see if the tool still reports Intersections.

Optionally using Process Intersections
Automatic Mapping performs the processing for automatic mapping and also for processing
intersections. It also makes available Process Intersections control. There are only a few cases where
you would want to run Process Intersections:

• If the IOCP file assigned all the CHPIDs, you can skip Automatic Mapping and go directly to checking for
intersections.

• There may be situations for which you want to process intersections without the overhead of automatic
mapping.

For example, if you run automatic mapping and there are intersections, you might use Manual Mapping
to reset some CHPID assignments. To avoid the overhead of automatic mapping, you can click Process
Intersections to see if your manual changes fixed the intersections.

If the tool reports intersections, see “Resolving Intersections” on page 79 for help.
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Chapter 8. Manual mapping

Few users would want to use manual mapping exclusively to map CHPIDs to PCHIDs. To use only manual
mapping, you would need to thoroughly evaluate the allocation of devices to channels and you would
need an in-depth knowledge of the availability characteristics of the machine structure. Therefore, most
users prefer to use automatic mapping. (For details about automatic mapping, see Chapter 7, “Assigning
priorities, automatic mapping, and processing intersections,” on page 63.)

However, certain situations require you to perform manual mapping before you can perform automatic
mapping:

• The CHPID Mapping Tool cannot automatically assign CHPIDs of type CIB or CS5. If the AID
assignment in the IOCP file is not valid, you can reset it during Hardware Resolution (see “Performing
hardware resolution to remove PCHIDs” on page 35). Then to enable Automatic Mapping, use Manual
Mapping to reassign those CHPIDs.

• You might also prefer to use manual mapping:

– If you have specific requirements about how CHPIDs should be laid out on the machine.
– To make minor mapping adjustments.
– To eliminate intersections after you use Process Intersections. (For details, see “Resetting CHPIDs

in manual mapping” on page 82.)

This chapter provides general information about the Manual Mapping view and the steps to perform
manual mapping. See “Manually assigning CHPIDS of type CIB and CS5” on page 69 for information about
using manual mapping to assign CHPIDs of IOCP type CIB and CS5.

The Manual Mapping view
After hardware resolution is complete, there are no red-circled Xs in either the Hardware Resolution or
Channel Type Summary panes of the Hardware Resolution view. Manual Mapping then becomes
available. Figure 106 on page 85 shows Manual Mapping available in the bar of buttons in the top of the
tool.

Figure 106. Manual Mapping available

You can either click Manual Mapping (by default the third button from the left) or click the arrow beside
Manual Mapping. Clicking the arrow displays two choices, which represent two different workflow
formats. Figure 107 on page 85 shows these choices. 

Figure 107. Manual Mapping button in group

The Hardware ->I/O format conceptualizes the workflow from the hardware point of view. After you
select a hardware port, the tool filters the list of available CHPIDs based on your choice; then and you
select the CHPID or CHPIDs. Alternately, the I/O -> Hardware format allows you to select a particular
CHPID; the tool filters the hardware, and you select the location to assign to the CHPID.

Clicking Manual Mapping has the same effect as clicking Manual Mapping > Hardware -> I/O.
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Panes in Hardware -> I/O format
Figure 108 on page 86 shows the Manual Mapping pane using Hardware - > I/O format.

Figure 108. Manual Mapping view – Hardware -> I/O format

The Hardware -> I/O version contains five panes:

Projects
See “The Projects pane” on page 15 for details about the Projects pane.

Columns
This pane is the lower-left pane (by default). When you click in a pane with columns of information,
the Columns pane lists the column headings. You can hide a column by clearing its check box; you can
undo this change by selecting its check box again. Figure 109 on page 86 lists the columns in the
Hardware pane (of the Manual Mapping view). 

Figure 109. Columns pane showing available columns for Hardware pane

See “The Hardware Resolution pane ” on page 29 for descriptions of these columns.
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If you have clicked to select a row in the I/O Config pane, the Column pane displays a list of the
columns in the I/O Config pane. Figure 110 on page 87 shows this.

Figure 110. Columns pane showing available columns for I/O Config pane

Note: The Columns pane might be empty when you first open the Manual Mapping view. When you
click in Hardware pane or I/O Config pane, the tool displays the appropriate list of the columns.

A check mark in a check box indicates that the particular column is displayed in the Hardware pane.
To control the information that is displayed in the Hardware pane, you can select and clear the check
boxes in the Columns pane.

Hardware
The Hardware pane is, be default, positioned as the top middle pane. This pane shows the hardware
ports available to accept assignments for CHPIDs. It consists of a table containing rows and columns
of information you use to perform manual mapping. For details, see “The Hardware Resolution pane ”
on page 29.

CHPID Groups
Although the CHPID Groups pane is present in this view, the CU Priority function determines the
contents of this pane; for more information, see “Optionally assigning priorities ” on page 64.

Figure 111 on page 87 shows the CHPID Groups pane.

Figure 111. CHPID Groups pane

By default, this pane is positioned as the lower middle pane. The pane consists of a table with
information you use later when looking for intersections. (See Figure 98 on page 78 for an example of
this pane with intersections.)

I/O Config

The I/O Config pane is, by default, positioned as the right pane. Based on your selection in the
Hardware pane, the CHPID Mapping Tool filters CHPIDs it displays in the I/O Config pane. Figure 112
on page 88 shows this the I/O Config pane.
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Figure 112. I/O Config pane

It consists of a Hide Spanned control and a table with rows and columns of information you use to
perform manual mapping. See “The I/O Config pane – Columns of information and Hide Spanned
control” on page 90 and “Hide Spanned” on page 92.

The Hardware pane – Columns of information

The Hardware pane shows the hardware ports available to accept assignments for CHPIDs. Figure 113 on
page 88 shows the Hardware pane in the Manual Mapping view.

Figure 113. Hardware pane in Manual Mapping view
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Note: You can sort the columns of information in any pane containing tabular information. For details, see
“Sorting information” on page 25. You can also rearrange the columns in any pane containing tabular
information; see “Reordering columns within a pane” on page 27.

The following table lists the default column headings and describes the information.

Note: You can control which columns of information are displayed in the Hardware pane by selecting or
clearing the check boxes in the Columns pane. A check mark indicates that this particular column is
displayed in the Hardware pane.

Table 6. Column headings and descriptions of contents

Column name Description

(Blank or Plus Sign) This column may be blank or, after you map multiple CHPIDs to a
PCHID, may contain a plus sign.

Feature Details the feature code (FC) at current row's the hardware
location.

Source Provides the location where the channel's link plugs into the
processors.

Cage Provides a 4-character field indicating the frame and cage location
where the particular port is located. The frame can be one of the
following types:
Z

Indicates it is located in the Z-frame.
A

Indicate it is located in the A-frame.

The cage identification consists of its Y (vertical) and X
(horizontal) axis. The Y mapping is numeric. The X mapping is
alphabetic. An example would be A15B, indicating A-frame, Y axis
15, X axis B, as viewed from the front.

Slot/Port Indicates the card location within the cage and the port location
on the card. For example, LG14/J.00 indicates card slot 14 and
that the port is the first port on the card (the top port).

Channel Type Indicates the type of card containing the port.

PCHID Specifies the PCHID assigned to the port.

CHPID Is initially blank unless this PCHID has been assigned a CHPID.
After you assign a CHPID to a PCHID, the value of the CHPID
assignment is displayed in this field.
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Table 6. Column headings and descriptions of contents (continued)

Column name Description

Assigned By Indicates how the CHPID assignment was made. Values can
include the following sources of the assignment:
Manual

You made the assignment using manual mapping.
Automatic

You made the assignment using automatic mapping.
IOCP

The IOCP source made the assignment.
Ignore

You have selected to have the tool ignore this CHPID.
Delete

You have selected to have the tool ignore this CHPID. When
the IOCP input file is exported, the CHPIDs with the Delete
assignment are not included in the exported file.

Config File
The CHPID Mapping Tool forced an assignment because of
configuration file requirements.

Note: In certain cases, the CHPID Mapping Tool identifies PCHIDs
with new values by displaying "Config File" in the Assigned By
column. This applies to CHPIDs affected by:

• An upgrade (for example, from a z990 to a z10 EC)
• a Miscellaneous Equipment Specification (MES) in a z10 EC, z10

BC, z9 EC, or z9 BC.

You are recommended not to change these assignments.

The I/O Config pane – Columns of information and Hide Spanned control

Based on your selection in the Hardware pane, the CHPID Mapping Tool filters CHPIDs it displays in the
I/O Config pane. Figure 114 on page 91 shows the columns of information in the I/O Config pane.
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Figure 114. I/O Config pane

Table 7. Column headings and descriptions of I/O config pane

Column name Description

(Check box and arrows) The check box is for selecting CHPIDs. The left- and right-facing
arrow icons indicate input and output throughout the tool; they
are not functional.

CHPID The CHPID number, which is the number of the channel
subsystem.

Assigned By Identifies the method by which the CHPID was assigned. Values
can be:
Manual

You made the assignment using manual mapping.
Automatic

The tool made the assignment.
IOCP

The IOCP source made the assignment.
Config File

The CHPID Mapping Tool forced an assignment because of
configuration file requirements.

Note: In certain cases, the CHPID Mapping Tool identifies PCHIDs
with new values by displaying "Config File" in the Assigned By
column. This applies to CHPIDs affected by:

• An upgrade (for example, from a z990 to a z10 EC)
• a Miscellaneous Equipment Specification (MES) in a z10 EC, z10

BC, z9 EC, or z9 BC.

You are recommended not to change these assignments.

IOCP Type For a complete description of the IOCP CHPID types, see the
Input/Output Configuration Program User's Guide.

Chapter 8. Manual mapping  91



Filtering information

With the Hardware > I/O format, clicking a row in the Hardware pane filters the information that the tool
displays in the I/O Config pane. The tool displays only compatible CSSs. (With the I/O > Hardware format,
clicking a row in the I/O Config pane filters the information in the Hardware pane.)

Hide Spanned

Figure 114 on page 91 shows all the CHPIDs in the I/O Config pane. CHPIDs can be spanned. Clicking
Hide Spanned filters the list of CHPIDs by hiding all but one of the spanned CHPIDs. Figure 115 on page
92 shows this:

Figure 115. Hide Spanned hides additional (spanned) CHPIDs

Panes in the I/O -> Hardware format
Figure 116 on page 93 shows the Manual Mapping pane using I/O -> Hardware format.
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Figure 116. Manual Mapping view - I/O -> Hardware format

You can use this view to select a CHPID and assign hardware to it.

Filtering information
With the I/O > Hardware format, clicking a row in the I/O Config pane filters the information that the tool
displays in the Hardware pane. (With the Hardware > I/O format, clicking a row in the Hardware pane
filters the information in the I/O Config pane.)

Performing manual mapping
Perform the following steps to do manual mapping:

1. Open the Manual Mapping view. To do so, click Manual Mapping or click the arrow beside Manual
Mapping (by default the third button from the left). This opens a list of choices. Figure 117 on page
93 shows this list. 

Figure 117. Manual Mapping button in group

I/O -> Hardware
Displays the Manual Mapping view in the I/O > Hardware format. You probably use this format less
frequently than the Hardware > I/O format. In this chapter, you use the Hardware > I/O format.
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Hardware -> I/O
Displays the Manual Mapping view in the Hardware > I/O format. This is the more commonly used
format. This format is the default (unless you change it).

The Hardware > I/O format is also displayed if you clicking Manual Mapping (and have not
changed the default).

The rest of the steps are based on the Hardware >I/O format of the Manual Mapping view.

You perform manual mapping mainly in the Hardware pane and the I/O Config pane of the Manual
Mapping view. Figure 118 on page 94 shows these panes.

Figure 118. Manual Mapping view – Hardware pane and I/O Config pane
2. Select the target row containing the PCHID to which you want to map one or more CHPIDS. Figure 118

on page 94 shows the CHPIDs in the I/O Config pane.

Note:

a. The tool displays only compatible CHPID types in the I/O Config pane.
b. If the CHPID column is blank, no selections are available in the I/O Config pane. Figure 119 on page

94 shows an example: 

Figure 119. CHPID column is blank - no selections in I/O Config
3. Map one or more CHPIDs to the PCHID by selecting one or more check boxes in the first column of the

I/O Config pane.
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• If you map a single CHPID to the selected PCHID, the tool inserts a check mark in the selected check
box. The tool also makes the following changes:

– In the Hardware pane, in the CHPID column, the tool inserts the CHPID number.
– In the Hardware pane, in the Assigned By column, the tool inserts the value Manual.
– In the I/O Config pane, in the Assigned By column, the tool inserts the value Manual.

Figure 120 on page 95 shows these changes.

Figure 120. Selecting a check box to map a single CHPID to a PCHID

Note:

a. If you map a single CHPID to a PCHID, the tool might automatically map an additional CHPID to
that PCHID. Figure 121 on page 95 shows an example. The user selected the check box (at
0.F1) in row three of the I/O Config pane, and the tool selected the check box (at 0.F1) in the
ninth row as well. 

Figure 121. CHPID Mapping Tool automatically maps a CHPID to a PCHID

Notice the (S) after the value Manual in the Assigned By row in the Hardware pane. The (S)
indicates the CHPID is spanned.

b. If the I/O Config pane has a green box inside a check box, this means the CHPID is already
assigned to another PCHID, and you cannot assign it to the target PCHID. Figure 122 on page 96
shows an example. 

Chapter 8. Manual mapping  95



Figure 122. Green squares in check boxes in I/O Config pane
c. On some channels, you can define multiple CHPIDs. You can define up to 16 CHPIDs on one AID.

OSA Express3 cards can have four ports (for two PCHIDs) or two ports (for one PCHID).
d. If you map more than one CHPID to a PCHID (or the tool does this for you automatically), the tool

makes the changes listed in Step “3” on page 94 with two differences:

– In the Hardware pane, in the first column, the tool displays a plus sign.
– The tool inserts the value Multiple -> in the CHPID and Assigned By columns. 

Figure 123 on page 96 shows an example of these differences.

Figure 123. Plus sign in first column and "Multiple -> in CHPID and Assigned By columns

Clicking the plus sign expands the row. Figure 124 on page 97 shows the expansion. 
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Figure 124. Expanding the information in the Hardware pane

- The plus sign changes to a minus sign.
- The expansion shows the value Manual in the CHPID and Assigned By columns.

Note: The (S) after Manual indicates the CHPID is spanned
4. Optionally, save your session. See “Saving a session” on page 48.
5. Optionally, create another IOCP file with statements that include the assignments you have made with

the tool. For details, see“Exporting an IOCP input file” on page 51.

Undoing a manual mapping assignment
When a CHPID is assigned to a PCHID, a check mark is present in the check box in the I/O Config
pane.Figure 125 on page 97 shows this. 

Figure 125. Selecting a check box to map a single CHPID to a PCHID

To undo assigning a CHPID to a PCHID, click the check box containing a check mark. The check box is
cleared and the mapping is undone; the tool no longer shows the CHPID number in the CHPID column of
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the Hardware pane or the word Manual in the Assigned By columns of the Hardware or I/O Config panes.
Figure 126 on page 98 shows this. 

Figure 126. Available CHPIDs displayed in the I/O Config pane

Manually assigning CHPIDS of type CL5, HYL, ROCE, and ROC2
Manual mapping may be required for PCHIDs with multiple ports allowing multiple CHPIDs per port. This
includes zHyperlink Express, Coupling Express LR, and the RoCE cards. The CHPID Mapping Tool only
supports mapping of a single CHPID to each PCHID port. Assignment of additional CHPIDs to a PCHID
port must be done manually.

Manually assigning CHPIDS of type FC and FCP
Beginning with IBM z14, the Kraken FICON I/O adapter cards with 2 ports do not allow mixing of FC and
FCP CHPIDs on an adapter card. The CHPID types must be the same on both ports of an adapter card. If
one PCHID port is assigned a CHPID of TYPE=FC, then the CHPID assigned to the other port on that
PCHID must also be TYPE=FC, and the same rule applies for TYPE=FCP. The CHPID Manual Tool cannot
evenly distribute FC and FCP devices and fully populate the cards when both CHPID types are defined.
Manual mapping must be done.
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Chapter 9. Reports

This chapter describe using the CHPID Mapping Tool to create, save, view, and print reports.

Keep in mind that reports are static, which means that they do not necessarily reflect the current data.
They reflect the data as it was at the time you saved the report.

Previewing and saving reports
Note: The person who will install the I/O cables during system installation needs one of the reports. The
Port Report, sorted by location, is recommended. The installer can use this to help with labeling the
cables. The labels must include the PCHID or cage/slot/port.

Preview Report and Save Report are located near the top of the IBM CHPID Mapping Tool window.
Figure 127 on page 99 shows these buttons.

Figure 127. Preview Report and Save Report buttons

Click Preview Report or Save Report to display choices. The choices are the same except Save Report lists
one additional selection.
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Figure 128. Choices under Preview Report and Save Report

CHPID Report
This report is similar to the one e-config produces but includes the CHPID values. It shows the values
based on a hardware location (primarily slot).

Port Report
This report presents each I/O port, type, and, if assigned, the CHPID and its Assigned By value.

Four items are under Port Report. Figure 129 on page 100 shows these. 

Figure 129. Port Report options

• Sort by Location
• Sort by CHPID
• Sort by Database Order
• Sort by Channel Type

Fiber Cable Chart
This assists with documenting cabling from an I/O port to a device.

FTS Report
This is a specialized report to assist with documenting the cabling from the trunking brackets to the
patch panel.

Note:

1. The FTS Report is called FQC Report for machines preceding z10.
2. z10 EC and z10 BC support this report for FICON and ESCON channels only.
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3. This report is available only if the FTS (or FQC) feature is present in the CFReport file (or hardware
configuration file).

Control Unit Report
This report is available only after IOCP has been loaded. It shows the hardware connections
associated to each control unit. It provides a good record of how you prioritized the control units and
any availability intersections you may have encountered.

CHPID to Control Unit Report
This report is available only after IOCP has been loaded. It shows information about each CHPID,
hardware connection, and the control units on which it is defined.

Batch Save...
This is available only under Save Report. This is used when the user wants to save several reports at
the same time. You can select which reports to be saved and what format is required. The current
supported formats to save reports are PDF, HTML, and CSV.

Previewing reports
Perform the following steps to preview a report:

1. Click Preview Report. The tool displays a list of types of reports. Figure 130 on page 101 shows this
list. 

Figure 130. Choices under Preview Report
2. Click one of the items under Preview Report.
3. If you click Port Report you additionally need to click a Sort by... selection. Figure 131 on page 102

shows these additional selections. 
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Figure 131. Additional options under Port Report

The CHPID Mapping Tool displays the Reports view.

Figure 132 on page 102 shows this.

Figure 132. The Reports view displaying CHPID report as an example

The Report view
The Reports view is similar for all types of reports. It consists of two panes:

Projects pane
By default, this is positioned on the left. (It is on the top left if there are two panes on the left.) See
“The Projects pane” on page 15 for a detailed description.

Report pane
By default this is positioned on the right. It displays the report you selected.Figure 132 on page 102
shows a more detailed example of the CHPID Report in the Report pane.
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Saving reports
You can save individual reports or save multiple reports in batch.

To save an individual report, perform the following steps:

1. Click the arrow beside Save Report. This displays types of reports. Figure 133 on page 103 shows
this. 

Figure 133. Choices under Save Report
2. Click one of the report choices under Save Report.
3. If you click Port Report you additionally need to click a Sort by... selection. Figure 134 on page 103

shows this. 

Figure 134. Additional options under Port Report

The tool displays a window with a wizard for creating a new report. Figure 135 on page 104 shows an
example of the CHPID Report window.
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Figure 135. Window for saving the CHPID Report

The window is similar for all types of reports.
4. When saving a report, you can optionally change the default file name. Table 8 on page 104

summarizes information about the default files names. 

Table 8. Summary of default file names of reports

Report name Default file names

CHPID Report chpid.rpt

Port Report pchid.rpt

Fiber Cable Report Fiber Cable.rpt

FTS Report FTS.rpt

Control Unit Report Control Unit.rpt

CHPID to Control Unit Report chpidtocu.rpt

5. If you want to save the report in a folder other than the workspace folder, select Save outside
workspace. If you do this, the tool makes available the External path and File type fields.
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Figure 136. Window for saving the CHPID Report outside the workspace

a. Type the External path value in the field or click Browse to open the Browse For Folder window in
which you navigate to the path and click OK.

b. If you want to save the report in HTML, select HTML. The tool selects PDF by default. This remains
selected after you select HTML. If you do not want to save an additional version of the report in PDF
format, clear PDF.

6. If you do not want to save an additional copy of the report in the workspace folder, clear Save to
workspace. (By default, the tool selects Save to workspace. This remains selected even if you select
Save outside workspace.)

Note: The tool creates the workspace folder when you open it for the first time.
7. Click Finish. The tool saves the report in the specified directory. Table 9 on page 105 summarizes the

file names of the reports. Notice that, if you save outside the workspace folder, either .pdf or .html
follows the extension .rpt. 

Table 9. Summary of file names of saved report files

Report File name saved in workspace folder Saved outside workspace folder

CHPID Report chpid.rpt chpid.rpt.pdf or fn.rpt.html

Port Report pchid.rpt pchid.rpt.pdf or pchid.rpt.html

Fiber Cable
Report

Fiber Cable.rpt Fiber Cable.rpt.pdf or Fiber
Cable.rpt.html

FTS Report FTS.rpt FTS.rpt.pdf or FTS.rpt.html

Control Unit
Report

Control Unit.rpt Control Unit.rpt.pdf or Fiber Control
Unit.rpt.html

Chapter 9. Reports  105



Table 9. Summary of file names of saved report files (continued)

Report File name saved in workspace folder Saved outside workspace folder

CHPID to Control
Unit Report

chpidtocu.rpt chpidtocu.rpt.pdf or chpidtocu.rpt.html

The tool saves the report and displays the Reports view. See Figure 132 on page 102.

To save multiple reports, perform the following steps:

1. Click Save Report. This displays types of reports. Figure 137 on page 106 shows this.
2. Click Batch Save under Save Report. The Multi-page Editor File window is displayed. Figure 137 on

page 106 shows this. 

Figure 137. Multi-page Editor File window
3. If you want the CHPID Mapping Tool to export an HTML file rather than a PDF, select HTML to change

the default.
4. Select the report or reports you want. If you select Port Report, additional choices about the sort

order become available and you are required to select one.
5. If you want to save reports to a folder other than the default Documents and Settings folder, click

Browse. This opens the Browse For Folder window where you can create a new folder or select an
existing folder; click OK when you are done.

6. Click Finish.
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Printing Reports
Saved reports can be HTML files or PDF files. You are recommended to print all reports. You can use a
viewer associated with the file type to print a file. For example, you can print an HTML file from a browser
or a PDF file from Adobe Acrobat reader.

Note: When you print using Internet Explorer, certain reports, such as CHPID reports and FTS reports,
may have page breaks at logical sections.
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Chapter 10. Troubleshooting and support

This chapter provides directions for reporting a problem or submitting a suggestion on the CHPID
Mapping Tool through Resource Link and ViewBlue. It also provides a brief list of frequently asked
questions (FAQ).

Submitting a problem or suggestion
You can report a problem or submit a suggestion through Resource Link. Alternately, your IBM
representative or IBM business partner can report a problem for you using ViewBlue.

Submitting a problem or suggestion with Resource Link
IBM monitors feedback from Resource Link during normal U.S. business hours.

Perform the following steps to submit a problem or suggestion to the tool developers:

1. On the main Resource Link site, click Feedback in the navigation bar on the left. This opens the
Feedback form, as shown in Figure 138 on page 109. 

Figure 138. Feedback form
2. Select CHPID Mapping Tool in the Category list.
3. Enter your comments, making sure to include the version of the tool you are using (this is displayed

in tool title bar).
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4. Complete the fields for first and last names and email address, optionally select the check box
regarding information use, and click Submit.

5. Save the work in a session file if possible. A session file can be used by the development team to
analyze the problem.

6. If Internal Tool Error is encountered, the log file named chpid.log, found in the tool installation
directory (usually c:\program files\ibm\chpid) can be sent to the development team for quick
resolution, along with the session file, hardware data and IOCP file.

Submitting a problem with ViewBlue
For issues outside U.S. business hours, please contact your IBM representative/Business Partner to
report the problem using ViewBlue.

The following instruction are for IBM representatives/Business Partners:

1. Open https://www.ibm.com/ibmlink/feedback.
2. Open up a feedback to report the problem.
3. Click Report a problem.
4. Identify the subject of the feedback as Configurators.
5. Select eConfig.

Note: Users who do not have access to ViewBlue can open up a feedback from the eConfig application.

Frequently asked questions (FAQ)
Q: Why do I get the following error message while importing a CFReport?
CHPID Mapping Tool could not identify the I/O device with the following feature codes: n n...

This might be due to modifications of the CFReport, 
or the version of the CHPID Mapping Tool being not current. 
If so please download the latest version before trying to load 

A: The tool maintains a list of feature codes. It is possible for the CFReport to include recently introduced
feature codes that the installed version of the tool does not yet support. If the installed version is not the
latest, you should download the latest upgrade of the tool from the Resource Link website. If the error
still occurs, you should contact support.

Q: How do I find the version of the installed tool?

A: After you start the tool, you can display the version by clicking: Help > About.

Q: When I load a session file, why does the tool display a window with the following message?
Tool has detected a more recent saved session. 
This is because the CHPID Mapping Tool periodically saves changes to a separate session file to 
avoid
productivity loss from desktop or application failures. 
If you exit the tool or a desktop or application failure occurs before you save the latest changes
to a session file, then the automatically saved session file is newer than your session file. 
Alternately you might not want to save some changes. 

Do you want to load the automatically saved session file?

A: The tool has an autosave feature that periodically saves changes to a separate session file to avoid
productivity loss from desktop or application failures. If you exit the tool or a desktop or application
failure occurs before you save the latest changes to a session file, the tool displays this message to inform
you that the tool detects an autosaved file for the same CCN with later changes. You can load the auto
saved file to recover lost changes.

Q: How do I know if a CHPID is spanned in the Manual page?

A: Spanned CHPIDs are displayed in bold text in the CHPID table.
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Appendix A. An explanation of configuration files

The following information applies if you are performing:

• An upgrade (for example, from a z990 to a z9 EC)
• A MES for a z10 EC, z10 BC, z9 EC, or z9 BC to another z10 EC, z10 BC, z9 EC, or z9 BC.

On the z890 and z990, customization information is stored in files on the SE. The files are called
configuration files (or 'config files'), and they are named based on the PCHID value (physical location) of
the channel. The following table lists channel or CHPID types that have config files on a z10 EC, z10 BC,
z9 EC, z9 BC, z990, or z890 and the kind of information stored in these files: 

Table 10. Channel or CHPID type information in configuration files

Channel or CHPID type Information stored in configuration files

OSA-Express2 or OSA-Express3 Any user specified MAC addresses and OAT tables

1000BaseT channel defined as CHPID type OSC Console session information

The following is true for an upgrade (for example, from a z990 to a z10 EC) or an MES (for example, for a
z10 EC, z10 BC, z9 EC, or z9 BC). If channels or CHPIDs have associated configuration files, the CHPID
Mapping Tool can assign PCHIDs to your logical CHPID definitions or move a CHPID definition to a new
location. This can occur regardless of whether channels are moving. The CHPID Mapping Tool can
override PCHID assignments for the following channels supporting CHPID type OSC, OSD, OSE, and OSN:

• OSA Express3

– 3362
– 3363
– 3367
– 3369
– 3370
– 3371
– 3373

• OSA Express2

– 3364
– 3365
– 3366
– 3367
– 3368

• OSA Express

– 1364
– 1365
– 1366
– 2364
– 2365
– 2366

The following explains how the system preserves the config files on an upgrade (for example, from a z990
to a z9 EC). However, it is ultimately your responsibility to have a record or backup of the customization
data stored in config files. You should always make a backup record:
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• For OSA-Express2 and OSA-Express-3 channels, record all user-assigned MAC addresses using the
Display or alter MAC address function in Card specific advanced facilities or user-specified OSA
Address Tables (OAT).

Note: If you are an OSA/SF user, a better method is to use OSA/SF to back up and restore the
configuration information for your OSA-Express2 and OSA-Express-3 channels.

• For CHPID type OSC (OSA-ICC), use the Export source file function in Manual configuration options.

For an upgrade (for example, from a z990 to a z9 EC), most of the existing channels cards to move from
the old machine to the new machine are rebalanced to take advantage of the availability characteristics of
the new machine. This rebalancing also takes into consideration any new channels that may be added as
part of the upgrade. The configurator creates machine configuration data and reports that contain
information on which PCHIDs have been relocated.

The information contained in the configurator data is used to create a file that the service representative
uses as part of the installation (or MES) activities of the new z10 EC, z10 BC, z9 EC, or z9 BC. This file
supports the relocation for channel types that have specific files containing customization data.

It is important that the file names containing the customization data be renamed to the new PCHID value.
As part of the installation (or MES) process, the service representative is presented with a window
(Migrate Channel Configuration Files) that shows the movement of PCHIDs based on the information
contained in the manufacturing-provided file. This function provides the capability to automatically
rename the files so that they reflect the new PCHID values (so that the customization data is not lost and
follows the physical movement for those cards). If you used the CHPID Mapping Tool to perform the
CHPID to PCHID assignments (a process that is recommended), then the service representative need only
accept the values on the window and the files are copied correctly. On the windows displayed, the service
representative can change the "TO" PCHID during this process.

This can accommodate those customers who choose not to do not follow the recommendations (those
who do not use the CHPID Mapping Tool or who override the CHPID Mapping Tool default assignments).
If the customer and service representative team preplan and develop their own from-to-PCHID list,
manual entry can be used to override the file.

It is strongly recommended that you use the CHPID Mapping Tool to configure the CHPID to PCHID
assignments because the tool ensures that logical CHPIDs are assigned to the new PCHID values. The
tool has been changed to handle the previously described issues. When the appropriate files have been
loaded into the tool (that is, CFReport file and IOCP file with PCHID assignments for the z990 or for the
current z10 EC, z10 BC, z9 EC, or z9 BC if this is an MES to a z10 EC, z10 BC, z9 EC, or z9 BC), the tool
assigns new PCHID values to those affected CHPIDs based solely on the physical movement of the
channel cards. If you use the manual mode, these PCHIDs have an identifier ('Config File'). You are not
recommended to change that these assignments.

You are recommended to use automatic mapping rather than manual mapping for most of your mapping
needs. If you use the automatic mapping, the CHPID Mapping Tool protects any CHPID/PCHIDs that have
been assigned because of config files unless you direct it not to do so. The following outlines the process:

1. You click Automatic Mapping. The tool displays the Reset CHPID Assignments window. This window
includes three or four options. The fourth option is Reset CHPIDs assigned by CMT for config files.
The tool displays this option only if the CHPID Mapping Tool reset assignments for an upgrade or an
MES. (Figure 97 on page 76) shows an example of the Reset CHPID Assignments window, but this
example does not include the fourth option.)

2. You select one or more of the options. You are recommended not to select Reset CHPIDs assigned by
CMT for config files.

• If you select Reset CHPIDs assigned by CMT for config files, the tool resets CHPID Mapping Tool
assignments for config files.

• If you select any options other than Reset CHPIDs assigned by CMT for config files, the tool does
not reset config file assignments. It protects any CHPID/PCHIDs that have assigned through config
files.

3.
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After you run automatic mapping and review the intersections, if you believe the config file assignments
are causing unacceptable intersections, you are recommended to use manual mapping to reset only
those config file assignments that are causing the unacceptable intersections. Remember it is your
responsibility to have backed up the customization data (and to restore it to the PCHID to which the
logical CHPID has been assigned).

After you have completed working with the CHPID Mapping Tool, one of the available reports will identify
all the CHPIDs that have new PCHID values. A subset of these may have had config files associated with
the old PCHIDs. The service representative can use this report to verify or change the to column of the
Migrate Channel Configuration Files window.

The use of the mapping tool is highly recommended for this migration because it ensures the logical
CHPIDs are assigned to the new PCHID values. The IOCP file (for the machine being upgraded) that is
input to the CHPID Mapping Tool must contain the current CHPID to PCHID assignments for the CHPID
Mapping Tool to perform the function as previously described.
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Appendix B. Notices

This information was developed for products and services offered in the US.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing         
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785 
US

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprise is
entirely coincidental.

Notices
This information was developed for products and services offered in the US.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
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your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing         
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785 
US

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprise is
entirely coincidental.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks of International Business Machines Corp., registered in
many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other
companies. A current list of IBM trademarks is available on the web at "Copyright and trademark
information" at http://www.ibm.com/legal/copytrade.shtml.

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other
countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, and the Windows logo the are trademarks of Microsoft Corporation in the United
States, other countries, or both.
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Class A Notices
The following Class A statements apply to this IBM product. The statement for other IBM products
intended for use with this product will appear in their accompanying manuals.

Federal Communications Commission (FCC) Statement

Note: This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. IBM is not responsible for any radio or television interference caused by using other than
recommended cables and connectors or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Compliance Statement

This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité à la réglementation d'Industrie Canada

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

European Community Compliance Statement

This product is in conformity with the protection requirements of EU Council Directive 2014/30/EU on the
approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A Information Technology
Equipment according to European Standard EN 55032. The limits for Class A equipment were derived for
commercial and industrial environments to provide reasonable protection against interference with
licensed communication equipment.

European Community contact:
IBM Deutschland GmbH
Technical Regulations, Department M372
IBM-Allee 1, 71139 Ehningen, Germany 
Tele: +49 (0) 800 225 5423 or +49 (0) 180 331 3233
email:  halloibm@de.ibm.com

Warning: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.
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VCCI Statement - Japan

The following is a summary of the Japanese VCCI statement above:

This is a Class A product based on the standard of the VCCI Council. If this equipment is used in a
domestic environment, radio interference may occur, in which case the user may be required to take
corrective actions.

Japan JIS C 61000-3-2 Compliance

For products less than or equal to 20 A per phase, the following statement applies:

For products greater than 20 A, single-phase, the following statements apply:

For products greater than 20 A per phase, three-phase, the following statements apply:
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Electromagnetic Interference (EMI) Statement - People's Republic of China

Declaration: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user may need to perform practical action.

Electromagnetic Interference (EMI) Statement - Taiwan

The following is a summary of the Taiwan EMI statement above:

Warning: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user will be required to take adequate measures.

IBM Taiwan Contact Information:

Electromagnetic Interference (EMI) Statement - Korea

Germany Compliance Statement

Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse A EU-Richtlinie zur
Elektromagnetischen Verträglichkeit
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Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2014/30/EU zur Angleichung der
Rechtsvorschriften über die elektromagnetische Verträglichkeit in den EU-Mitgliedsstaaten und hält die
Grenzwerte der EN 55032 Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu installieren und zu
betreiben. Des Weiteren dürfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
übernimmt keine Verantwortung für die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung von IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung von IBM gesteckt/eingebaut werden.

EN 55032 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden:

"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im Wohnbereich Funk-
Störungen verursachen; in diesem Fall kann vom Betreiber verlangt werden, angemessene Maßnahmen
zu ergreifen und dafür aufzukommen."

Deutschland: Einhaltung des Gesetzes über die elektromagnetische Verträglichkeit von Geräten

Dieses Produkt entspricht dem "Gesetz über die elektromagnetische Verträglichkeit von Geräten
(EMVG)". Dies ist die Umsetzung der EU-Richtlinie 2014/30/EU in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die elektromagnetische Verträglichkeit
von Geräten (EMVG) (bzw. der EMC EG Richtlinie 2014/30/EU) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das EG-Konformitätszeichen -
CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
Tel: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:
IBM Deutschland GmbH
Technical Regulations, Abteilung M372
IBM-Allee 1, 71139 Ehningen, Germany 
Tel: +49 (0) 800 225 5423 or +49 (0) 180 331 3233
email:  halloibm@de.ibm.com

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55032 Klasse A.

Electromagnetic Interference (EMI) Statement - Russia
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Manual Mapping view (continued)
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views (continued)
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